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1 Foreword

This standard describes the requirements and procedures for the Three Dimensional Technical Data
Package (3D/TDP) solid model repository established and maintained by PAM-MTV. The 3D/TDP is
based on Creo Parametric Mechanical Design Automation software for the purpose of Computer Aided
Design (CAD). The 3D/TDP uses Windchill PDMLink Product Data Management (PDM) software
both products of PTC.
ithin the 3D/TDP system

shall follow the requirements of this standard regarding bot etric and Windchill

for data management and storage. Creo Parametric and Windchill PDML.in

All contractors and government personnel working with models contaj

PDMLink. Documents that are not solid model related but ise a TDP such as
packaging sheets, quality assurance provisions, electrical i : in Windchill
PDMLink.

1.1 Background
In order to take advantage of avail ‘ TV has been maintaining the
technical data system including 3D solid mod op, maintain, and provide these

3D/TDPs throughout the lifecycle o item. ywill be USed for development, production, life

e Better and faster engineering analysis capabilities (kinematic, dynamic, and structural analysis,
tooling design, etc.)

e Reduced TDP interpretation errors

In order to use solid models as a basis for the technical data it is important that the solid models
be built to a set of common standards, using sound modeling practices, and be fully defined.

Performing cosmetic modeling (in which a model looks like it is supposed to but is actually
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dimensionally incorrect), may be faster and easier; however, as a basis for product definition is

inadequate.

Appendix D.5 Checklists referenced within this standard, defines required criteria for promotion
approval to the Released state. Any requirements made by this standard must be met, whether or not

they are cited on the checklist.

The FMTV PDMLink User Guide document, referenced within thi
followed when using Windchill PDML.ink in conjuncture with

efines procedures to be
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2 Configuration Management Representations

2.1 Standards Application
The requirements of this specification apply to all objects, parts, assemblies, and/or drawings that are
submitted through the formal release process via Windchill Change Notice from In Work to Released.

2.2 Drawings Required

All parts and assemblies promoted to Released shall have associ
PDF copy of the latest (requires prior TACOM approv
representing the latest design configuration (i.e., the |
ECPs) shall be promoted through the release process. ply to Standard Parts, which are

defined in Appendix F.

2.3 Engineering Changes
Models/drawings shall be chang
shall conform to MIL-STD-

eering Change Proposals (ECPs) only. ECPs

2.5 Products
The Product in Windchill PDMLink for the FMTV 3D solid modeling TDP will provide enough detail

for files to be checked into the database in the appropriate location.

FMTV-MODELING-STD-100T Rev.L Page 3 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PAM-MTV

2.6 Object Status

The user making changes on a drawing, part, assembly, or other object for release in the FMTV
database shall set the Commonspace status to Checked Out while change is in progress. The status

should be applied when the drawings are identified for the ECP.

2.7 Security

This system security falls under the Windchill system security settings.

2.8 Revision Scheme
The initial release of drawings, parts and assemblies will be equent changes
will be from a one to three digit alphabetic character (ng i , , or

(i.e. [A,BL[C,... AAL [AB] [AC, ... [YYV] Y YW, [YYY]) E Y14.35M for further

information about Revision Scheme.

2.8.1 The part or assembly revision st At to its associated drawing and vice

versa. The Creo Paramets odel revision shall be the same for FMTV

drawings/models. Allg€ha awing will follow formal ECP procedures.

2.8.2 The revision 0 i displayed on all drawing sheets in accordance with

the currehtrace ) aWwing format. As new revisions of the models and drawings are

| be used for the current drawing.

2.9

Drawings submitted forfpromotion shall follow instructions found in FMTV PDMLink User Guide.

2.10 Quality Assurance

All parts, assemblies, and drawings submitted for promotion shall be checked in accordance with
Appendix D.5 Checklists.
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2.10.1 All Creo Parametric objects promoted to Released are required to pass the FMTV

ModelCHECK process.

2.11 Release Level Flowchart

The following flowchart illustrates the FMTV release scheme using the ECP2 or ERR process in

Windchill PDMLink.

Approwed
ECP2 Implementation Released
Resulting Drawing added at Creation
NOR Add Drawing Resolved )
ait for NORs to Resolve

From To Resolved
DWG DWG

Rev A Rev B

VEL FLOWCHART
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3 Part Modeling Standards

3.1 Part Modeling Practice

3.1.1 Parts should be functional and created in a logical sequence. Features should be simple

and be created such that they are easily modifiable by another user. Pauts shall have every

feature that the real part is required to have. For example, plastic should contain every

draft angle and radii detail expected on the real part. If text (e mber) is stamped or
molded into a part, that should also be modeled. Parts shou d on their own

without reference to other parts or assemblies.
3.1.1.1 If the part is a source controlled endor item control drawing, CAD
Files from the vendor will be requested. If the file is unavailable, all interface and

envelope dimensions shown

modeled in Creo Parametric.

sioning scheme for the new part will be shown with no created

drawing (unless required).

3.1.3 All modelS'shall regenerate successfully with all features in the unsuppressed state.
When parts are modified, the next higher assembly shall also be capable of being successfully

regenerated.

3.1.4 The latest FMTV_START_PART or FMTV_START_SHTML _PART shall be used for

part creation.
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3.1.5 Sheetmetal parts shall be created with the Creo Parametric Sheetmetal module.

3.1.6 All routed tubing or piping models and assemblies shall be created using the Creo Piping
and Cabling Extension.

3.1.7 All wiring and cabling models and assemblies shall be created using a combination of

Creo Piping and Cabling Extension.

3.2 Tolerances
All dimensions shall include tolerances as required to be sho
geometric tolerances, geometric tolerance datums, inspecti

dimensions are required, these shall be set in the mode

3.3 Materials

Materials shall be identified on the part in two

1. The materials section r Mo@ in Creo Parametric. Material file creation shall
custodia

3.4

Surface finishes shall be"shown on the part as required.

3.5 Model Notes

Sufficient model notes shall be used to describe the part and part features. I notes are intended to
apply to specific features, they shall be attached to those features. Notes found in the FMTYV start parts
include:
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a. Distribution_Note: The drawing distribution statement shall be included in a 3D note called
Distribution_Note.

b. Proprietary_Note: If a proprietary legend is required on the drawing, this legend shall be
entered on the model as a 3D note entitled Proprietary Note.

c. Export Control Note: The drawing export control warning note shall be included in a 3D note
called Export_Control_Note

d. Notel: Notel shall contain the current drawing standards.
e. Note2 — Note#: These notes shall be used to describe the mod quired for the drawing.

f. DRW_NOTE: This note is a summary of all the Note1-No i on 2D Parametric

drawing.
g. NoteO_DESIGN_INTENT: Note0 DESIGN_IN t design
intent. Design intent is any optional informatio i inks is valuable to those who

might view the model at some future point. An exa a design intent note is as follows:
THIS PART IS MADE OF ALUMINU
CORRODED DURING USE. USE OF ST
DUE TO TIME CONSTR

L WAS TESTED BUT
SIDERED BUT NOT PURSUED

3.6 Relations

Relations shall
FMTYV start i

regeneration. Relations found in feature CSO and ACSO of the

All parts will start W It datum planes and a default coordinate system identical to those found
in the FMTYV start models. The default datum planes shall be named FRONT, TOP, and SIDE. The
coordinate system shall be named CSO with its orientation as follows; Z axis is elevation, X axis is

along the length of the vehicle, Y axis across the vehicle width.

3.8 Part File Names

Parts shall be named using the following convention:

FMTV-MODELING-STD-100T Rev.L Page 8 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PAM-MTV

CAGE_PartNumber.prt i.e. 19207_8448510.prt

If the model requires an extension (or suffix) it will follow the convention described in Table 1 -

Model Name Suffix Usage.

Suffix Range
-001 -399 Fully detailed down level parts on a
Down-Level detailed parts that a
base number of the weldment
100 -150° e 001 thru -399, but the d
100. Fully detailed parts are s
-400 -499 Parts modified in the field for the a
-500 -599 Non-detailed dow
-5000 -
-600 -699 ling, piping, etc...)
-6000 -6999 models (cablln_g, piping, etc...) if more
-699 are required
-700 -799 Il as the extension _FEA)
-800

ed parts may also use the _def naming convention. Same intent
5 and shrinkwraps.

-999 or -gen on-useful generic components used in Family Tables.
_skel Skeleton Models
-opt, -oc Optional Configuration (either is acceptable)
-cast Use for castings when a casting is an Alternate Design
TaABLE 1: MODEL NAME SUFFIX USAGE
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3.8.1 Hardware File Names
Hardware naming convention shall generally start with -001 and is not required to follow
Section 3.8.

3.8.2 Exceptions
- Refer to Section 7 - Electrical for naming convention on Schematics and Electrical related

components.

- Refer to Section 8 - Piping for naming convention for Pipin

3.9 Model Views

All models shall have separately named views defining the T

FRONT datum plane, with the yellow side of the TOP datu facing up. The remaining
orthogonal views follow standard third angl jecti ice rent drawing models should be

created such that the named views correspond

3.10 Deformed Parts

Deformed parts will ase to case basis. If a part can be deformed in
numerous shapes (rivets)gthe C ad part. This makes it easier, rather than having
100+ deformed parts. In acditi omponents shall ALWAYS be considered first and is

preferred over a de . will help keep the data management aspect to a minimum.

3.10.2 When to use Deformed Parts
1. Create a deformed part if it will only be needed on a particular drawing. (Examples are
lanyards, cables, etc).
2. Create a deformed part if the non-deformed part causes a major interference.
3. Create a deformed part if the non-deformed part will not work in any way possible.
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3.10.3 Creating Deformed Parts from Tabulated Parts

If a deformed part is made from a tabulated part, keep the tabulation and add the -900 extension
after. (Ex: 19207_12345678-001 will be 19207 _12345678-001-900 when it is deformed).

3.10.4 Creating Deformed Parts with Flexible Components

The preferred option when creating deformed parts is using flexiBle”component functionality.

Flexible components allow the model to be represented in differen in different assemblies.

would not require that a second model to be created. he designer to vary dimensions,

parameters, resume or suppress features (or components if fle component is a sub-assembly).

3.10.5 Promoting Deformed Parts

3.11 Layers
The following layers shall be used in part mode (these exist in the FMTV start part). Other layers may

be added as needed, for example, a datum required on a drawing may be placed on a separate layer so

that it can stay on while the other datums are layered off.
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Layer name Layer Assignments gg,; i
DTM_AXES All datum axes Hide
DTM_CSYS All datum coordinate systems Hide
DTM_CURVES All curve features Hide
DTM_PLANES All datum plane features Hide
DTM_POINTS All datum point features Hide
G_DTM_PLANES | All geometric tolerance datum planes Hide
ITEM_ID Only the cosmetic/curve feature d Hide
NOTES All part notes Hide
SURFACES All surface features ape Hide
THREADS All cosmetic and actue Hide
XSEC_DATUMS Hide

3.12 Part Parame

Ing a part or assembly into the 3D/TDP Product

oted in the Input column.

e filled out, but will remain for legacy drawings. Windchill

Parameter Na Parameter Description Format Example | Input
01* | AGENCY Agency or service US ARMY *
02 | CAGE_CODE Original design activity CAGE code 19207 REQ
03 | CATALOG_NOMENCLATURE Nomenclature assigned by supply SPRING, HELICAL
04 | CHECKER_NAME Person that checked the original drawing K.BALL REQ
05 | CONTRACT_NUMBER Contract #-original design contract DAAE20-03-C-S023 REQ

FMTV-MODELING-STD-100T Rev.L
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. . Tank Automotive &

* *
06* | DESIGN_ACTIVITY Design activity Armaments Command REQ
07* | DESIGN_ACTIVITY _LOCATION Design activity city, state and zip code \é\(/)z(a)gen, MI 48397- REQ*
08 | DESIGN_APPROVAL_NAME Person who approved design A.TAYLOR REQ

STEWART &
- . STEVENSON
09 | DESIGN_CONTRACTOR Original design contractor SERVICES, SEALY -
AS US.A.
10 | DISTRIBUTION_CODE Distribution Statement (A, B, C, D, E, X) REQ
11 | DRAWING_APPROVAL_NAME Person who approved drawing REQ
12 | DRAWING_DATE Date original drawing create REQ
13 | DRAWING_NUMBER Drawing number the pag REQ
defined on
14 | DRAWING_REV Revision of current B Legacy
15 | DRAWN_BY JWENNER REQ
16 | ENGINEER_NAME 1 AWURFEL REQ
17 | ENGINEER_NAME_2 J.ZEBROWSKI -
18 | ERR_ECP_APPROVAL N.TAUBE -
19 | ERR_ECP_DATE YY-MM-DD REQ
20 | ERR_ECP_NUMBER d current revision TACV1234 REQ
21 ontroll_ed by International Traffic in Arms YES REQ
gulation
29 -NO PARAMETER, contains jewel NO )
23 | MATERIAE Person who approved material for design M.CHURCH REQ
24 | MATL_CLASS Automatically filled out -
25 | MATL_GRADE Automatically filled out -
26 | MATL_HEAT TREAT Automatically filled out -
27 | MATL_NAME Automatically filled out -
28 | MATL_SHAPE Automatically filled out -
29 | MATL_SPECNO Automatically filled out -
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30 | MATL_TYPE Automatically filled out -

31 | MATL_UNS_NO Automatically filled out -

32 | MODEL_REV Revision of current model B Legacy
33 | MODELER_NAME_1 Primary Pro/E modeler J.WENNER REQ
34 | NEXT_ASSY_1 E';Ségi)ggﬁhggfj\% part no. (shall match 19847-001 REQ
35 | NEXT_ASSY_2 Second next higher assy part no. -

36 | NEXT_ASSY_3 Third next higher assy part no. -

37 | NEXT_ASSY 4 Fourth next higher assy part -

38 | NEXT_ASSY 5 Fifth next higher assy, -

39 | NEXT_ASSY_6 -

40 | NEXT_ASSY_7 -

41 | NEXT_ASSY_8 -

42* | NOMENCLATURE gg\g(\;((? SI\i.E\I\;I E\%VYE: REQ*
43 NOMENCLATURE_1 BODY ASSEMBLY, -

44 NOMENCLATURE_2 CARGO, MTV LWB | -

45 | NOMENCLATURE_3 Third line of drawing nomenclature -

46 | OZONE_DE YES-NO PARAMETER, ozone depleting NO )

47 | PART Itém part number 12423205 REQ
48 | PMIC Precious Metal Indicator Code A -

49 | QA_ENGINEER_ Quality assurance engineer P.FIESTER REQ
50 REMARKS See paragraph 3.12.2 PRELIMINARY Legacy
51 | SOURCE_CONTROL YES-NO PARAMETER, source control NO -

52 | SPEC_CONTROL YES-NO parameter, spec control NO -

53 | SPEC_NUMBER ﬁgftziggﬁfion Number, Used on SPEC ASME B18.2.1 -

54 | SPECIALTY_METAL YES-NO PARAMETER, specialty metal NO -
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55 | TOLERANCE_1 PLACE

Default tolerance if indicated on drawing 1 -

56 | TOLERANCE_2_PLACE

Default tolerance if indicated on drawing .03 -

57 | TOLERANCE_3_PLACE

Default tolerance if indicated on drawing .020 -

58 | TOLERANCE_ANG

Default angular tolerance if indicated on
drawing

59* | UNIT_WEIGHT

Mass value. (See paragraph 3.12.4) REQ*

60 | USED_ON 1

First used on item MTV A1P2 REQ

61 | USED_ON_2

Second used on item

62 | USED_ON_3

Third used on item

63 | USED_ON_4

Fourth used on item

64 | USED_ON_5

Fifth used on item

65 | USED_ON_6

66 | USED_ON_7

67 | USED_ON_8

68 | WEIGHT_UNIT

kg -

* These parameter values a
assembly relations.

atically generated from the FMTV start part and

AGE _‘CODE refers to the original design activity. If the current

than the original design activity then the current one is entered into

CURRENT DESIGN ACTIVITY CAGE CQODE 19200

ARMAMENT RESEARCH, DEVELGPMENT AND ENGINEERING CENTER
PICATINNY ARSEMAL, NEW JERSEY 0/806-3000

Us ARMY
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3.12.2 The parameter REMARKS should initially default to PRELIMINARY. This will

automatically appear on the drawing until the value is removed during the final stage of the

release process.

3.12.3 The parameter NOMENCLATURE will automatically be assigned a value based upon

FMTV start part relations. The value is equal to the sum of t
NOMENCLATURE_1, NOMENCLATURE_2, and NOMENC

entered appropriately by the modeler.

individual parameters
RE_3, which shall be

3.12.4 The part or assembly parameter UNIT W is automatical ed out by Creo
Parametric (PRO_MP_MASS calculated para rt or assembly is regenerated.
This is accomplished using relations found in th rt parts. The parameter value for

unit weight shall be representative of the weight of its hysical counterpart.

3.13 Part Units

Creo Parametric system units atch the following:

METRIC ENGLISH
mm in
kg Ibm
sec sec
Temp °C °F

TABLE 4: UNIT SYSTEMS

Note: English and metric unit systems exist in the FMTV start parts

FMTV-MODELING-STD-100T Rev.L Page 16 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PAM-MTV

4 Assembly Modeling Standards

4.1 Assembly Modeling Practice
4.1.1 Assemblies shall have all components and features of the assemblies defined, including

pins, screws, nuts, washers, the part number etc. This includes items such as decals, warning

labels, bulk items, etc., which are required to be attached to the assemb

4.1.2 Assembly of models shall follow a logical sequence.

4.1.3 Assembly features shall only be used for features man t the assembly level and
not for features created on individual parts.

4.1.4 All assembly models shall regenerate succe y with all features components in
the unsuppressed status. When assemblies are i higher assembly shall also be

capable of being successfully regenerated.
4.1.5 All assembly components shal nless the function of the assembly

benefits from adding certain degrees gl ections. The FIX constraint
should avoid being used. The use of C

case.

4.1.6 The latest F

4.4 Assembly Default Datums

All assemblies will start with default datum planes and a default coordinate system identical to those
found in the FMTV start parts. The default datum planes shall be named FRONT_ASSY,
TOP_ASSY, and SIDE_ASSY. The coordinate system shall be named ACSO with its orientation as

follows; Z axis is elevation, X axis is along the length of the vehicle, Y axis across the vehicle width.
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45 Assembly File Names

Assemblies shall be named using the following convention:

CAGE_PartNumber.asm i.e. 19207 _12432300.asm

For additional guidelines for assembly naming refer to Section 3.8 Part

4.6 Model Views
All models shall have separately named views defi TOM_VIEW,

exist in the FMTYV start part. The FRONT view is oriente the yellow (or primary) side of the
FRONT datum plane, with the yellow side lane facing up. The remaining

The following la assembly mode (these exist in the FMTYV start assembly).
Default State

a. Hide

b. DTM_AXES A1l datum axes Hide

c. DTM_CSYS All datum coordinate systems Hide

d. DTM_CURVES All curve features Hide

e. DTM_PLANES All datum plane features Hide

f. DTM_POINTS All datum point features Hide

g. G_DTM_PLANES | Aj| geometric tolerancing datum planes Hide
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h. NOTES All assembly notes Hide
i SURFACES All surface features and quilts Hide
J. THREADS All cosmetic and actual threads Hide
k. XSEC_DATUMS All cross-section datums Hide

TABLE 5: ASSEMBLY LAYERS

48 Bulk Items

Bulk items are classified into two different categories. These items red to as TYPE 1 and

TYPE 1bulk items are non-solid representations of object i assembly. They shall be used for

all objects that must appear in the Bill of Matesia ut do not require solid models.

Templates folder.

It is not acceptable to creatéa the base object in the assembly and add Table

TYPE 2 bulkai reo Parametric 3D solid model to represent the item. The models

nstalled state or flexible component category.

4.9 Assembly Parameters

Follow the same guidelines as Section 3.12 Part Parameters.
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410 Relations
Relations shall have no errors upon regeneration. Relations found in feature ACSO of the FMTYV start

assembly are required.

4.11 Surface Finishes

Surface finishes shall be created on the assembly as required.

4.12 Reference Objects

Reference components displayed in phantom on installatj r similar drawings not be fully

associated 3D models. These should be developed ust a or 3D model data as required
(refer to Appendix D.3 for 2D and Appendix D.4 for 3 eight Backdrop Creation. Any

components specifically defined on the dr ust have id associative 3D model as per

Paragraph 4.1.1.

4.13 Assembly Unit

Follow the same guideling
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5 Drawing Creation Standard

5.1 Dimensions
Drawings shall display dimensions that are directly parametric to the model upon which they are
based. Specifically, these values shall be either driving or driven dimensions.

5.2 Geometric tolerances
Geometric tolerances shall be attached to the base dimensions icable and not added as

unattached notes.

53 Formats
Standard FMTYV 3D/TDP drawing formats located in the S
and Formats in Windchill PDMLink shall be

CAD Template Library / Start Parts

Standard FMTV 3D/TDP dra i : cated in the Standard CAD Template Library /

5.6 Notes
All notes on drawings shall originate as model notes in .prt and .asm files, except when deemed
necessary.
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5.7 Drawing Views
2D draft entities shall be related to the drawing view to which it belongs. Views shall be capable of
being moved with no entities of the view being left behind.

5.8 Drawing Line-Weights

The following line weights and colors shall be used:

COLOR STYLE

WHITE Normal Weight

YELLOW Thin Weight
GRAY Phantom
RED Bold
WHITE Phantom

59 Quality Assurance
The preferred method for ig
of having a separate QAP ¢

The drawmgidistributi ement shall appear on each sheet of a drawing. (This is automatically

e Distribution_Note is filled out in the drawing model.)

5.11 Revision Block
Revision blocks shall conform to ASME Y14.35M

5.11.1 For legacy conversion ECP’s, include only the latest revision, redrawn with

change/redrawn without change and ECP number in lieu of full delineation of the changes on
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the drawing for Administrative changes. For individual Major or Minor changes, those
changes shall be listed in the revision block.

5.11.2 For design effort ECPs that make drawing changes the revision block shallincluding the
latest revision, redrawn with change, ECP number and full delineation of the changes on the

drawing.

5.11.3 For design effort ECPs that release a new drawin ision block shall include

Initial Release, Product Baseline, and the ECP number.

5.12 Associated Models

All parts that are defined by a drawing shall be relat the dr even if they are not used in a

view on the drawing.

5.13 Parameters
The following parameters shall be fi
e Part_ Number
e Drawing_Dat

e Drawn_By

e QA _Engineer_Name

e Drawing_Number
e Revision

e Distribution_Code
e |tar

e Err_Ecp_Number

FMTV-MODELING-STD-100T Rev.L Page 23 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PAM-MTV

e FErr_Ecp_Date*
e Err_Ecp_Approval*

*These parameters are not required to be filled out at the In Work state. Their values shall be
determined later in the release process.

5.14 Layers
Drawing layers may be created as required to properly display info n on the drawing. Layer
status may be set (this works independent of the part/assembl to properly display

information on the drawing.

5.15 File Names

Drawings shall be named using the following convention:

CAGE_DrawingNumber.drw i.e. 19

5.16 Drawing BOM
BOM balloons will use afSta ia : ches (9.525 mm). If the numbers within the
balloon extend beyond the N the g0t the text will be decreased to best fit within the
standard balloo C.13 for additional information.
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6 Templates

Creo Parametric object templates are used to customize the default content of newly created
objects. Object templates belong to one of two categories: model templates (also known as start parts)
and drawing templates. Model templates are standard Creo Parametric models that contain predefined

features, layers, parameters, named views, and other attributes. Drawing templates are special drawing

files that contain instructions to create drawing items, including views, ta
lines, notes, parametric notes, and dimensions. Drawing templates are

environment. The basis for a drawing is the Creo Parametric form

6.1 Start Parts

The start parts already contain a default coordin

notes, relations, and parameters. There are start parts e

and assembly models as named below.

o fmtv_start _part.prt

o fmtv_start_shtml_part.prt

e fmtv_start_assy.asm
e fmtv_start _diag

The parameters that a

required by th

stem, d

It datum plan

ormats, symbols, snap
rrently used in the FMTV

, views, layers,

olid models, sheetmetal models,

of the start models are listed below in Table 7, most of which are

er Description Format Example Source
Agency or service US ARMY Relation
Yes-No, Used in relation YES User
» Yes-No, Set to YES for Cabling assembly | NO User
CAGE_CODE Original Design Activity CAGE Code 19207 Relation
CATALOG_NOMENCLA Nomenclature assigned by supply User
CHECKER_NAME Person that checked original K.BALL User
CIRCUIT_NUMBER* Circuit Number used for Electrical J159 User
CONTRACT_NUMBER Contract # - original design contract DAAEQ7-03-C-S023 User
DESIGN ACTIVITY Design Activity (from relations) TANK AUTOMOTIVE & Relation
ARMAMENTS COMMAND
DESIGN_ACTIVITY _LOCATION | Design Activity City, State and Zip Code | \yARREN, M1 48397-5000 Relation
(from Relations)
DESIGN_APPROVAL_NAME Person who approved design A TAYLOR User
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chemical

DESIGN_CONTRACTOR Original design contractor STEWART & STEVENSON User
SERVICES, SEALY TEXAS U.S.A.
DISTRIBUTION_CODE Distribution Statement (A,B,C,D,E,X) A User
DRAWING_APPROVAL_NAME Person who approved drawing A.TAYLOR User
DRAWING_DATE Date original drawing created YY-MM-DD User
DRAWING_NUMBER Drawing Number 12423205 User
DRAWN_BY Person who created original drawing JWENNER User
ENGINEER_NAME_1 Primary design engineer User
ENGINEER_NAME_2 Secondary design engineer User
ERR_ECP_APPROVAL Approving official of latest ECP User
ERR_ECP_DATE Date current revision released User
ERR_ECP_NUMBER ECP that caused current revision User
ITAR Controlled by International Traffic in User
Arms Regulation
JEWEL_BEARING Yes-No Parameter, contains jew User
MATERIAL_ENGINEER Person who OK’d material fi User
MATL_CLASS Automatically filled out (fro User
MATL_GRADE Automatically filled out (from re User
MATL_HEAT_TREAT User
MATL_NAME User
MATL_SHAPE User
MATL_SPECNO User
MATL_TYPE User
MATL_UNS_NO User
MC_ERRORS 0 User
MODELER_NAME_1 JWENNER User
MODEL_CHECK YY-MM-DD User
NEXT_ASSY_1 12419847-001 User
NEXT_AS User
NEXT_ Third néxt higher assy part no. User
NEXT_AS Fourth next higher assy part no. User
NEXT_ASSY_ Fifth next higher assy part no. User
NEXT_ASSY_6 Sixth next higher assy part no. User
NEXT_ASSY_7 Seventh next higher assy part no. User
NEXT_ASSY_8 Eighth next higher assy part no. User
NOMENCLATURE Part Name BODY ASSEMBLY, CARGO, MTV | Refation
NOMENCLATURE_1 (Ffi;ft d’;'at\’,;iln;;‘a(‘;fg;‘:rfe%f Nomenclature BODY ASSEMBLY, User
NOMENCLATURE 2 Second N_b_2 characters of Nomenclature CARGO, MTV LWB User
(for drawing)(from rel)
NOMENCLATURE 3 Remaining characters of Nomenclature User
- (for drawing)(from rel)
OZONE_DEPLETING_CHEMICAL | Yes-No Parameter, Ozone depleting NO User
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PART_NUMBER Item part number 12423205 Relation
PIPING_ASSY* Yes-No Parameter, set to YES for NO User
PMIC Precious Metal Indicator Code A User
PTC_COMMON_NAME* PTC Common Name User
QA_ENGINEER_NAME Quality Assurance engineer P.FIESTER User
REMARKS General Remarks PRELIMINARY User
SOURCE_CONTROL Yes-No Parameter, Source Control User
SPEC_CONTROL Yes-No Parameter, Spec Control User
SPEC_NUMBER Specification Number (SPEC Parts Only) User
SPECIALTY_METAL Yes-No Parameter, Specialty Metal User
TOLERANCE_1 PLACE Default tolerance if indicated on drw User
TOLERANCE_2 PLACE Default tolerance if indicated on drw User
TOLERANCE_3 PLACE Default tolerance if indicated on drw User
TOLERANCE_ANG Default tolerance if indicated on drw User
UNIT_WEIGHT Mass computed in Creo Parametri User
USED ON_1 First used on item User
USED_ON_2 Second used on item User
USED_ON_3 Third used on item User
USED_ON_4 Fourth used on item User
USED_ON_5 Fifth used on i User
USED_ON_6 Sixth used on i User
USED_ON_7 Seventh used on User
USED_ON_8 User
WEIGHT_UNIT Relation

* Non-Designated Para

6.2 Formats

FMTV-MODELING-STD-100T Rev.L
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7 Electrical

7.1 Schematics

7.1.1 Schematic File Names
Schematic naming convention shall follow the format below: (Note: Schematics are used for
reference to drive the overlay that is contained on the production dravyi
CageCode_PartNumber
Example:
19207_12506185.dgm
19207 _12506185-001.dgm (For tabulated harn

7.1.2 Schematic Overlay Process

Schematics shall be created using an overlay proces procedure will insert an overlay of
e a diagram updates or changes,
it will change on all drawings where th

time of the present state of a diag i pdate with any changes parametrically.

Overlays will also rgqu rned off in the diagram and the diagram saved

in that condition. If it ere'will be noticeable differences in the title blocks and

formatting patti a diagram is different from that of a drawing.
The overlay will need to'Be placed on a blank sheet in the drawing. This can be used to bring
diagram da ing and relay the changes in the diagram to the drawing, but revisions
will not be po om within the drawing. Use the rev block from the drawing to track the
changes for the diagram on the overlay sheet. Alternatively, the user can create a rev block in the
diagram to force the information to be updated in the diagram. It also keeps the diagram ready
to be printed independently. The rev block that would be on the blank sheet in the drawing gets

deleted to prevent a duplicate rev block from showing on the drawing.
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Diagram Setup:

e Turn off the page formatting on the sheet to be overlaid.
e Place arev block on the diagram (This is only needed if the rev block from the drawing is not
utilized)

The diagram may need BLANK sheets added for the automatic table be populated with the

correct sheet number.

Drawing Setup:

Insert a blank sheet where the overlay should appear.

Delete the rev box from the new blank sheet; the di rev box will be used.

Insert the diagram overlay.

Converting

If a schematic a sts in the system as a standalone 19207 SC12345678.dgm file, the

following process should be used to incorporate the schematic into the drawing.

1. Rename the schematic from 19207 sc12345678.dgm to 19207_12345678.dgm

2. Create a DUPLICATE OBJECT of the existing schematic and name it
19207 _sc12345678.dgm (This is needed since the original, newly renamed, schematic will
still drive the drawing; however a schematic is needed to document the superseded schematic

from a CM perspecitve).
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3. Onthe DUPLICATE OBJECT schematic, add SUPERSEDED BY 12345678 above the title
block and update the rev block to state that the schematic was superseded and incorporated
into drawing 12345678.

4. Follow Creating a Diagram Overlay method.

7.1.3 Spool File Requirements

dministrators have the
within this folder. All
ms/Spools LIBRARY in

Spools should only be checked in by a Spool administrator. Only Spo
rights to check items into the Spools folder and create or modify S
Spools should be checked in and stored in the Routed
Commonspace.

Spool naming convention shall follow the format below:
CageCode_PartNumber (Government Part N
Example:
19207_12423132-004.spl (Government Part
81349 M16878/14BJE9.spl (Spec. Number)

or Spec Number

Spool files shall include the following pasameters:

Parameter Name Parameter Used On Example Value
Mil Spec Number of Gove 19207_12420924-
Name - 8 All Spools
wire, tubing,€ic... 001
Cage_Code All Spools 19207
. Electrical, 18 AWG,
Description All Spools White
Units All Spools mm/inch
Mass_Units All Spools kg
Density All Spools kg/mm~2
Color All Spools White
Color_Cog All Spools WHT
Wire/Cable
Insul_type Type Spools GXL
Wire_Gauge Wire/Cable 18 AWG
Spools
Min_Bend_Radius inimum radius a wire/cable/sheath can All Spools 8
Thickness The diameter of the wire/cable. \évlre/CabIe 2
pools
Number_of_Conductors The number of conductors in a cable. Cable Spools 5
Sheath_Type Specifies the type of sheathing for this spool. Sheath Spools | Tape, Tube, Shrink
Outer_Diameter Indicates the outer diameter of the tube sheathing. | Sheath Spools | 12
Preshrink_Inner_Diamete Indlcatgs the pre-shrunk diameter of SHRINK Sheath Spools | 10
r sheathing.
Wall_Thickness Indicates the thickness of the sheathing. Sheath Spools | 0.5
Width Specifies the tape width for tape sheathing. Sheath Spools | 20
TABLE 8: SPooL FILE PARAMETERS
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Not all parameters will be used depending on the type of spool used. Use all of the
parameters above when applicable.

Color Color Code
White WHT
Black BLK
Red RED
Blue BLU
Green GRN
Yellow YLW
Orange ORG
Gray GRY
Violet VLT
Brown BRN
Tan TAN

Pink
Table 9: Color Code

7.1.4 Schematic Spacing

Schematic shall use the minimum spacing : overlapping while being clearly
visible when printed on an Agize, sheet.

Use tab agram

WIRE o comonenr, Terw | COLOR | CE | GAUGE | INSULATION |DESCR IPT oK
12423132-004 e CTaiE R WHITE | WHT I GXL  |RIGHT FRONT MARKER FEED
21 12473132004 - E(')éig:”izlb_e WHITE | WHT 14 GXL  |MARKER FEED
21-489-B L A R WHITE | WHT B GXL  |RIGHT CENTER MARKER FEED
21-489-C . Eéﬁ’sﬁMQ'E WHITE | WHT ¥ GXL  |RIGHT REAR FEED
21-488-D 24231980 /320 JETL L R R WHITE | wHT 14 GXL  |LEFT FRONT MARKER FEED

FIGURE 3: DIAGRAM_CIRCUIT_LIST.TBLE EXAMPLE

7.1.6 Schematic Circuit Numbers

Schematic circuit numbers shall follow the numbers assigned in document 12506111. Circuit
numbers that are used multiple places require an alpha-extension. (Example: 90-A, 90-B...)

7.1.7 Circuit Description
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Circuits shall show the circuit number, gauge, and color code on each wire. Circuit description
shall come from document 12506111.

P1260

6048-18 AWG-WHT |
RIGHT MAIN WINCH

6‘ L) 4 C' .":"- | 8 !{\ W 'G lI|'|lI | T E
FIGURE 4: CIRCUIT DESCRIPTION EXAMPL
7.1.8 Reference Designators

Schematic reference designators shall follow the numb

Designator
CBXX
TLXX
EXX
PXXX
JXXX

eference designator, connector function, and pin-out orientation on
igure 5

o
|
RIGHT MAIN WINCH
fe

FIGURE 5: CONNECTOR EXAMPLE
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7.1.10 Phantom Box Requirements

Phantom boxes shall be used when a system or sub-system is shown in a simplified form.
Phantom boxes require a label of 6.35 mm (.25 inch) height that describes the sub-system and
shall use the phantom line  type. Refer to 6

a0 02 _BLK_IFYC _&0)

42781 CONVERTER BOX
FIGURE 6: PHANTOM BOX EXAMPLE

Schematic symboltext orientation shall be primarily left to right and secondary bottom to top.
The symbol should be descriptive and should show reference designators and pins. When printed
on an A size print, the symbol should be clearly visible.
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7.1.12Twisted Pairs/Shields

Twisted Pair wires shall be shown as needed per design intent, while shields should always be
shown. (Refer to Figure 7: Rigid or Smooth lines are acceptable)

FIGURE 7: TWISTED PAIR(S) EXAMPLE - RIGID VS. SMO

7.1.13Splices

Butt splices, not through splices shall be used whe
Note: Splices are a manufacturing process and n

7.1.14Wire Breaks

Wire breaks shall be depicted as follo indi SH.#, REF_DES).
(Refer to Figure 8)

TL26D

| +——WIRE_ SH #, REF_DES

BREAK EXAMPLE

Top-level schematics shall be organized by function; meaning one function per page. (Example:
ABS, CTIS). Phantom box section above applies to top-level schematics. A visual representation
of connector contact gender shall be shown.

7.1.17Start Part (Diagram)

Refer to Section 6.1 - Start Parts
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7.1.18Formats (Diagram)
Refer to Section 6.2 — Formats
7.1.19Schematic Diagram File

The schematic diagram file shall be promoted along with the drawing and models. The

odels. The schematic

parameters for the diagram file shall match those of the drawing

revision shall also match the revision of the drawing where the o is located on.

7.1.20Source Control Drawing Schematics

At a minimum, an Interface Control Diagram shall ncluded on Source rol Drawings;

however, a schematic is preferred when sufficie
7.1.21Drawing Properties
Diagram files shall use fmtv_diagram ! setup for diagram

7.2 2D Drawings
7.2.1 Tables

Two Dimensional dra inclu | of Material table listing all components used and
. Also, a harness variation table shall be shown listing all harness
harness_drawing_table.tbl) table (Figure 9) can be utilized

itten in order for the table to look correct. Two tables are
based on preference.

2 TAPE, INSULATED, ELECTRICAL 56536
I TAPE, GLASS CLOTH 19207
10 TUBING. CONVOLUTED 19207
g 420929-00 SLEEVING. INSULATION 19207
8 2743 12420924-002 TUBING, CONVOLUTED 19207
7 9145 om | 12423132-004 WIRE, ELECTRICAL. GAL 19207
§ 3 WS2T 1442 CONN, PLUG, ELLGT SOCHET 36906 B3, B2, Bl
5 3 MS20659-121 LUG, TERMIMAL 96506 TL200, TLI199, TLI&S
4 6 MA3d36/1-1 BAND MARKER B1349
3 | ATC-30 FUSE, 30 AMP IUWIE
2 \ 12424956 FUSE/CIRCUIT BREAKER HOLDER, ATC 15207
i \ 12420928-007 MARKER, HEAT DONDABLE WIRE 19207
FIH
NoD{m PART NUMBER DESCRIPTION CAGE CODE JEERLICE
PARTS LIST
FIGURE 9: HARNESS_ BOM.TBL SAMPLE
FMTV-MODELING-STD-100T Rev.L Page 35 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

7.2.2 Connector Pin Position

Connector pin position shall be shown from the front face and label as the front. Reference
designator and function shall be shown as required. Empty terminals will be plugged per
12420908.

7.2.3 Connector Description
Connector reference designators and function/description sh sho Il connectors shall
show all components with pin outs.
7.2.4 Harness Dimensions

Harnesses shall be dimensioned from connector front
eyelet. Dimension units are vendor specific.

nterline of bundle, or center of

7.2.5 Two Dimensional Drawing

E OF ELECTRICAL
DRAWING

T TOLERANCES SPECIFIED ARE
AND SHALL NOT BE USED FOR

ION: APPLY THE FOLLOWING
IL-STD-130,

DATE MFR YYYY/MM/DD
e ALL CIRCUIT NUMBERS AND REFERENCE
DESIGNATORS SHALL BE IAW 12506111.
(This note is used ONLY if the drawing has a schematic located on it)
e Any note required to show design intent or to clarify the manufacturing process.
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7.2.6 Splices

Splices locations shall be dimensioned and noted with the reference designator.

7.2.7 2D Harness Drawing Nomenclature

e Harness - A combination of wires, cables, connectors, and/or related components.

e Cable Assembly - Multiple conductors, single sheath betw 0 connectors.

e Generic names are no longer acceptable (i.e. No drawin be titled CABLE
ASSY)

7.2.8 2D Harness Layout

When a harness has too much detail to show on e page, iled views shall be used on
additional pages.

7.3 3D Harness Modeling

Refer to SECTIONS a Namesvas 3D harnesses follow the standard naming
convention

sm (Routed Assembly)

t (Harness Part, within Routed Assembly)
fg (Manufacture Part)

asm (Flat Harness Sub Assembly)

7.3.2 Connectors

Connector assemblies shall be used for connectors requiring other components (I.E. contacts,
plugs, TPA...) Connector assembly names shall follow the following convention:
CageCode_HarnessNumber-ReferenceDesignator.asm
(i.e. 19207_12345678-J01.asm)
Connector entry ports shall be named according to the pin name. For example if the pin is “1”;
the entry port shall be named “PORT_1” or if the pin is "A"; the entry port shall be named
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"PORT_A". ("ENTRY_PORT" is also acceptable for generic ports) Refer to Figure 10 for
example

13207 _12500000-17.45k 00a073s
----- 5 MoteO_DESIGN_INTENT

----- £ Proprietary_Mate
----- £= Distribution_Mate
----- £5 DRwW_NOTE

----- F7 SIDE_ASSY ¢
----- £7 TOP_agsy 3
----- F7 FRONT_ASSY
- ]

G- 1 19207_12259040-3PRT  [9.211237
&9-[T] 19207_12258939-2-902. 45| 0.000573
-1 19207_12258939-1-902. PF| 0.000513
G- 1 159207 _12256935-1-902 PF| 0.000619
A PORT_1
-2« PORT_2
-2« PORT_3

----- P Inzert Here <
FIGURE 10: CoN

able within its own harness part.
ntained within the box. Multiple harnesses are allowed to
e only if interference is unavoidable.

3D harness mode
schematic.

hall be “driven” by a schematic and not created without reference to a

7.3.5 Splices

19207 _Splice.prt shall be utilized, the part is located in the / STANDARD CAD TEMPLATE
LIBRARY / Start Parts and Formats folder in Commonspace.
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7.4 Electrical Checklists

Harness Assembly Checklist

Harness Assembly

File Name: CageCode_HarnessPartNo-600.asm

below)
All connector assemblies are assembled to a coordinat
The harness path coordinates, points, and axes are
All harness parts (i.e. band markers, ....) are assembled
The correct layers have been created in the i modeling standards
All unnecessary layers are hidden in the sk

The assembly and skeleton were created us

The skeleton features have ‘ ach features purpose, i.e. a coordinate system for a

Is the unit weig ate and reasonable for the harness

All parameters have been completed

OOoOt0f0d O 0o 0o OotofbdoOofOo O O
3
g
)

Model check has been completed on this assembly
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Connector Assemblies

File Name: CageCode_HarnessPartNo-RefDes.prt

Skeleton Name: CageCode_HarnessPartNo-RefDes_skel.prt (Skeleton is NOT required, applies to all
steps below)

All connector parts are assembled to a coordinate system in the skeleton part

Entry port coordinate systems are named Port_# and are located in the main

Dooogooogogoood g o
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Harness Part

File Name: CageCode_HarnessPartNo-600.prt

Logical reference has been established

All connectors and components have been designated as cabling components
All entry ports have been designated

All wiring features have been created from the logical reference

A network has been created for the harness part’s routing path (optional)
All wires and cables have been routed and marked complete

Bundles representing convoluted tubing and insulation sheathing ed and routed

Do ooodood

Model check has been completed for this pal ened from Pro/INTRALINK)
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Detail Drawing Checklist

Drawing File Setup

Correct format has been used.

Title block information is correct without spelling errors

Verify correct distribution and proprietary notes are used from 782 for
Distribution and proprietary notes are place on all sheets in the cor, oc
Drawing title accurately represents the harness, it is not a gen
Default part is the lower level flattened harness assembly
There are no drawing items interfering with the rev bl

The correct layers are in the drawing and hidden

N I I O

Model check has been completed on the drawing

Harness Layout and Views
A full layout view has been placed with overa

Detailed views are used for

Ooooood

Harness Dime
Branch Dimensio e created from a single starting point from the main trunk

Dimensions are from the face of the connector to the breakout starting location

Dimensions for ring terminals are from the center of the eyelet to the breakout starting location
There are no stacked dimensions along a branch or the main trunk

Dimensions match those specified by the engineer, may require overwritten dimensions

Splice locations are dimensioned. If several are in one area, a detailed view should be used

I I I A

All components along a path have a dimension to reference their location

FMTV-MODELING-STD-100T Rev.L Page 42 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

BOM Table and Balloons

BOM balloons are auto generated for all non cabling parts in the harness

BOM balloons for cabling components have been manually created, i.e. wires, tapes...
BOM balloons are separated for all occurrences of a component

BOM balloons are merged to a single leader line if several are present for a single component

BOM balloons should clearly mark where different wire spools are used
Use 3-region BOM table: Bottom region is the flat assembly, middle r arness part, and top region
is the 3D harness assembly.

Items not needed in the table are filtered out of the table

OO O OoOoggdao

BOM Table has been sorted by reference designators

Notes and Rev Block

OO0dood

IFICATIONS:
B. ASME Y14.5-2

IEEE/ASTM SI 10 SHALL BE USED
IN CONVERTING AND ROUNDING OFF.
1 INCH = 25.4 mm APPLIES.

SCOPE AND GENERAL REQUIREMENTS FOR
MANUFACTURING AND ACCEPTANCE OF ELECTRICAL
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CABLE ASSEMBLIES SHALL BE IAW DRAWING
12420908.

ITEM IDENTIFICATION: APPLY THE FOLLOW
MARKING IAW MIL-STD-130,
CAGECODE-PARTNUMBER-REV
MFR- MANUFACTURER'S CAGE CODE
DATE MFR YYYY/MM/DD

DIMENSIONS WITHOUT TOLERANCES SPECIFIED ARE
FOR REFERENCE ONLY AND SHALL NOT BE USED FOR
INSPECTION PURPOSES.

ALL CIRCUIT NUMBERS AND REFERENCE D

GNATORS S E IAW 12506111.
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Diagram Checklist

Sheet Setup

Correct format (e_fmtv_diag_1_2.frm)

Electrical_Diagram DTL File has been loaded or Start Template is used
All parameters for the diagram are completed

Grid set to 6mm Spacing

Snap to Grid is on when placing wires and components
File Name is CageCode_PartNo.dgm
Nomenclature 3 is set to “SCHEMATIC”
Scale set to NONE

Weight set to -----

Diagram has been checked for spelling e

Dodogooodogoodg

All Layers are hidden.

Connectors & Symbols

[] Connectors have a unig ied with the standards...
[l Connectors have co library file
] Reference Designator is at the top or left
] ing and/or single pin connectors are resized to 26mm
[]
[]
[]
[]
[] Correct splice s § are used
] All connectors and symbols have Entry Ports entered in the parameters
[] Connectors are aligned and organized on the sheet
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Wires & Cables

Wires and cables are using the correct spool file

Wires and cable conductors have a circuit number assigned, verified with the standards...
Wires have a functional description added in the DESC parameter

Wires have a parametric note for the description at the connector pin

Wires are organized neatly on the sheet with as few crossovers as possible

Wire labels and wire descriptions are spaced 1 grid away from the conne
Wire labels are aligned with one another at the connector
Wire label format: Circuit#-Gauge AWG -ColorCode
Wire break symbols are aligned

Wires are spaced evenly and aligned on the grid
Wire labels are readable and have no interferences
Twisted wires are shown using jogs and aligned with one along the same side of the sheet

Cable Symbols are used to indicate cable emblies

I

Cable conductors are assigned correctly i

Tables
[] Circuit run table has bee jst.tbl in common space)
display contents

all circuits have completed parameters
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Notes and Revision Block (No longer needed with OVERLAY format)

Required Diagram Notes have been placed (See Below)
Rev Block has been completed, correct format

Revision level matches the drawing and assembly
Distribution note has been placed

Proprietary note has been placed, if required

OoOodood

Distribution and Proprietary notes match the 782 form and the drawing
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8 Piping

8.1 General Overview
Piping assemblies shall be created in a way that maintains a Stand Alone status. The fittings

and/or components used to set the start and end points of a route shall be able to be deleted or changed

at any time without causing a problem / failure to the pipe. The pipes sh t be dependent on the

top-level assembly where they will be installed. If this is not done the an collapse or change with

separate and contained. The new piping assembly is createusiffffthe FMTV._Start_Assembly file. A
" _p" and the extension of .prt. This

ined in the upper level assembly. The actual
d CSO0s shall be placed to set the start and end
points for the route. Condpoi 8 fitting e constrained to vehicle geometry to set initial
locations, but require an ed the association to existing geometry in order to
establish a stand
Note: All F

g Assemblies andLine Stocks shall be created in METRIC units only.
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8.2 Line Stock Overview

A Line Stock file contains the shape, size, and material needed to be projected along the piping
path in the fabrication process. The Line Stock file defines the physical attributes of the hose.
Material and mass properties are defined with the Line Stock file and shall not be duplicated by
entering material specification into the material file of the part. The minimum bend radius of the hose
shall also be defined in the Line Stock file.

Line stocks should be pulled from the / STANDARD CAD TEMPLAT
Line Stock LIBRARY in Commonspace. The Line Stock fol
administrators. Only Line Stock administrators have the right
folder and create or modify Line Stocks. All Line Stocks sh i ed in the Routed

ARY / Routed_Systems /

ntrolled by Line Stock
into the Line Stock

Systems/Line Stock folder in Commonspace; see Figure

=1 Routed_Systerms

OLDER STRUCTURE

2 master library and is named according to the MIL specification or

-SAE nu i i to the diameter size and type; see Figures 12 & 13.

[y see_j4a_625_od stk 2 mil-ct-134449-250-ic stk !
Diameter Size SAE # or spec. Inner or Outer Diameter
FIGURE 12: SAE LINE STOCK EXAMPLE FIGURE 13: MIL SPEC LINE STOCK EXAMPLE
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¢ If no specification is available, the new line stock should be named after the part that is using
the pipe. This may be applicable to Source Control Drawings.

o If the type and size of line-stock does not exist in Commonspace, send the line stock
specification to a line stock administrator so it can be created.

e The Line Stock is assigned first in the set-up process of creating a route; see Figure 14.

Active Asm
Component
Pipeline
Foute
Fitting
Modify Pipe
Modify Dim
Fegenerate
Fabrication
Dranw g

Line Stock

. . . Use Create to make a new line stock.
Use "Write" to write a Line
Stock into a local w 08
Line Stock adng s

Use read to load an existing line stock. Do a
search in common space first and checkout the
Line Stock that is required. Never change or
modify existing line stocks.

Notify a member of the Line stock admin of
any errors in line stocks in Commonspace.

List
Fename
Done/Return

[ <l

FIGURE 14:LINE STOCK CREATE / READ

NOTE: Line Stocks shall be done in METRIC units.
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e Line Stocks contain information that is directly related to the pipe part; see Figures 15, 16, and 17.

This is the weight per
length of the hose or tube.
This number is provided
from the manufacturer or
spec. callout in kg/mm.

Minimum Bend /

Radius in mm

FMTV-MODELING-STD-100T Rev.L

25IN-5_4MM_OD_TUBE

LineStock | Designuls | Defined |

General Parameters

X

Stock Mo (1242057204
Material [ NylonaFiber
Grade I 1/4"00_¥_04"W
— X Section Section Type

" Rectangular " Hollow

% Circular * Solid V\

— Section Parameters

PpeOD |64

Thickness |1

Shape Type
v Straight i

¥ Flexiblz

T~

Xx | O

FIGURE 15: LINE STOCK SET-UP

Page 52

Line Stock Type

Section Type can be set to Solid or Hollow
depending on user preference. This will not
affect the Weight/Length outcome.
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x

Line Stock : 0_25IN-6_4MM_OD_TUBE

LineStock  Designfule | Defined |

Design Rule Parameters

Max Overall Length | 10000
Min Segment Length [1
Max Segment Length |236.22

Max Bends Mumber

Min Bend Separation

Min Straight Length

Min Bend Radius

Max Bend Radius

Min Bend Angle

Max Bend Angle

Bend Arc Threshold

NO_TABLE =]

g Maxmum pipe segment length.

v x | o |

FIGURE 16: LINE STOCK DESIGN RULE PARAMETERS
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Line Stock : 0_25IN-6_4MM_OD_TUBE

X

IJneStodtI DesignFule Defined |

Uzer Defined Parameters

¥ |ineStock

Mame Yalue

=

v X = |

FIGURE 17: LINE STOCK DEFINED TAB
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A Line Stock can also be created with a .txt file in Notepad or similar program. The following

example shows all of the parameters needed to create a Line Stock; see Figure 18.

. mil-dt-13444g-250-id.stk - Notepad
File Edit Format View Help

! Enter or modify parameters for the line stock.! You may use the help functionality of Pro/TABLE!
to enter pre-defined parameters.
STOCKNO TUBING

MATERIAL MIL-DTL-1344G
GRADE Al23

SECTION_TYPE HOLLOW

SHAPE STRAIGHT
CORMER_TYPES BEND

oD 12.7

WALL_THICKMNESS 3.17
BEND_RADIUS 1.5 2 3
BEND_ANGLE 90 45 &0
BEND_ARC_THRESHOLD 165
MAX_OVERALL_LENGTH 6.4516e+08
Max_MNUMBER_BENDS 5
MIN_BEND_SEPARATION 163871

MIN_STRAIGHT_LENGTH_END 163871
MIN_BEND_RADIUS 20483, 8
MAX_BEND_RADIUS 1.17987e+06
MIN_BEND_ANGLE 15
MAX_BEND_ANGLE 112.5

WT_LEN 5.69505e-05
MITER_CUT_LEN 819.353 1638.71 8193.53
MITER_CUT_MNUM 1 2 3

X_SECTION_TYPE CIRCULAR
RECTANGULAR_HEIGHT 32774.1
RECTANGULAR_WIDTH 32774.1
RECTANGULAR_ANGLE a0

BEND_TABELE_MAME NO_TAELE
MIN_BRANCH_SEPARATION 32774.1

MIN_BRANCH_ANGLE 30
MaX_SEGMENT_LEMNGTH 3.87096e+06
MIMN_SEGMENT_LENGTH 6

F A LINE STOCK
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8.3 Creating Routes / Pipelines

Pipe assemblies have a specific naming convention. A pipe assembly name is a combination of
the upper level assembly name and the pipe circuit number called out in the installation schematic.
The circuit number can be found in the schematic related to the installation. For example, for a pipe
assembly named 19207 12345678-6110.asm, the upper level assembly is 12345678 and the circuit
number is 110, and the hose size is .375". The pipe assembly is designated as,a pipe by the "6" as the
uld have accompanying
| be defined within the

first character in the dash number. Piping installations that are comple

schematic drawings. If a schematic is not provided, circuit num
installation drawing.

If a circuit number is not provided, then one must be . Thisi electing the next

should be a three digit number. The three digits re se type or size and should be

size. A sample pneumatic circuit number table

Circuit ldentification

Hose/Tubing Type

0XX

.25 Inch Bulk Tubing

1X

.375 Inch Bulk Tubing

.50 Inch Bulk Tubing

.625 Inch Bulk Tubing

Hoses with Crimped Ends

Hoses with Crimped Ends

TABLE 11: CIrcuIT ID TABLE

NOTE: All bulk tubing sizes are outer diameter and all rubber hose sizes are inner diameter.

FMTV-MODELING-STD-100T Rev.L Page 56 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

The fmtv_start_assy.asy has four parameters (see Table 12) that are dedicated to Pro/PIPING
that should be filled out in piping assemblies.  These parameters are PIPING_ASSY,
HOSE_LENGTH, WEIGHT_PER_LENGTH, and CIRCUIT_NUMBER. Piping assemblies should
have the PIPING_ASSY parameter set to YES. The default value is NO. The
WEIGHT_PER_LENGTH parameter should be filled in with the numeric value of the weight/length
, the HOSE_LENGTH

also be automatically

given in the line stock file used in the piping assembly. When this is don
parameter will be filled in automatically. The CIRCUIT_NUMBER

generated as it takes the last 3 digits of the filename and fills in the par,

would be purchased from a BOM. The piping assemb j representation of that part in its
routed state. The PART_NUMBER parameter is the n

drawing. For example, if a pneumatic piping

at will be listed on the assembly
30 represents a piece of 3/8" bulk

The following are four sp@ Vstart_assy.asm that supports Pro/PIPING

Parameter N3 4 Parameter Description Format Example | Input

S/INO parameter. Defines if the

bly is a piping assembly YES )

01 | PIPING_A

Automatically generated when

PIPING_ASSY is set to YES. 125 -

02 | HOSE_

Numeric value of the weight/length given
in the line stock file (manually entered, ..00417
should be same as line stock file)

03 | WEIGHT_PER

Automatically generated. Provides 3 digit

04 CIRCUIT_NUMBER S 110 -
- circuit number
TABLE 12: PIPING ASSEMBLY SPECIFIC PARAMETERS
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Port creation:

e Ports should always have the Z-axis orientated in the direction of pipe flow; see Figure 19.

O PORT AND Z-AXIS DIRECTION

o The Z axis ort should be collinear to the Z axis of the fitting port.
e The centerline e pipe needs to remain collinear to the Z axis of the fitting port beyond the

termination point of the fitting.
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The user will determine the actual routing of the pipeline. There are many ways to route each

pipeline and each user will have a preferred method. Two methods are shown in Figure 20.

(T} 19207_125DUMMY-6115.ASM

{7 SIDE_ASSY

{7 TOP_ASSY
{7 FRONT_ASSY
=¥ ACSO

2% ACS1

-2 ACS2

- () 81343_SAEJ6-6_3001CA PRT

@) 81343_SAEJE-6_1501C.PRT

¢ 3{ PORTO

- APNTO

-2« PORT1

-y APNTA

g Line Stock id 130

o8 19207_12422476-001

-4 Pipe Set Start id 133

4/ Pipe To Point id 134

-4/ Pipe Bxtend id 136

4/ Pipe To Point id 142

-4/ Pipe To Point id 148

B é’ 19207_12423246-6308
- Insert Here

FMTV-MODELING-STD-100T Rev.L

b £ Note0O_DESIGN_INTENT

207_125DUMMY-6115

/ Pipe Follow id 114
#-§7 19207_125DUMMY-6115_P.PRT
‘. Insert Here

CREATING PIPE ROUTE IN SEGMENTS VS. FOLLOWING CURVE
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8.4  Fittings and Other Piping Parts

Fittings should be created / updated to include an entry port for each connection point; see Figure 21.

FIGURE 21: Two EXAMPLES SAMPLE TEE FIT ENTRY PORTS

e Entry ports shall 0 of PORT*, i.e., PORT1, PORT2, or PORTA,
PORTB, etc.

assembled as b
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8.5 Fabricating / Creating Solid Pipes
Fabrication features create the actual part using the path and line stock as its guide. The
FMTV_Start_Part shall be used as a template.

Once a part is fabricated it creates a separate .PRT file. The fabricated pipe can be opened

individually when updating the layers.

Note: When fabricating a part, use the same -6xxx extension as the with the addition of the

p". (e.g., 12345678-6123 p.prt)

1) Select Fabrication & Pipe Solid from

will open.

w PIPING

Active Asm 2) Select the fmtv_start_part in the Copy at the bottom of the window;
see Figure 105.

Component

Fipeline 3) Expand the pipe route in

Foute

Fitting 4) Highlight the pipe segment

MModify Pipe

Modify Dirmn

| Fegenerate
| Fabrication
Dranving

Setlp

Cut Pipe
Delete Cut
Insulation
Delete Insul

| Pipe Solid
Extract mMdl
Done/Return

FIGURE 22: CREATING PIPELINE
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5&6

= Pipe Solid

View |

Select Assembly
FM [19207_12423246-6808 /

SEGMENT SOLID NAME [ |START PART
[T 15207_12423246-6808

B-g8 19207_12422476-001
(- 19207 _12422476-001 19207 124232466808 _F| ¥ |fmiv_start_pa

Male | Erase |

The pipe solid j

FIGURE 24: FABRICATED PIPELINE
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Figure 25 shows a standard pipe assembly with two fittings:
1. Create a pipe assembly with the correct naming convention

2. Assemble your fittings within the pipe assembly
a) Fittings should only be included in the piping assembly if they are permanently attached
to the hose, i.e., if the hose has crimped on hose ends.
3. Read the Line Stock into the assembly

4. Create a path for the individual pipe using a user's preferred method

5. Fabricate the pipe

19207_12423246-6803 ASM
----- = NoteD_DESIGM_INTENT
..... .f'_.E Moted
..... .{'_.E MNote?
..... .f'_.E Mote?
..... .f'_.E Moted
..... .f'_.E Mote5
..... .f'_.E Motek
L= Mote?
L= Proprietany

= Distribution_

..... ES DRW_NOTE

----- L7 SIDE_ASEY

Note: Straight_Point is not a

necessity as the modeler can

WD1CAPRT use Set Start at each port and

) B1262_BARJEE_TECICPRT extend from each to keep the

..... x % HT POINTD pipe straight entering into the

fitting.

o STRAIGHT_POINT1

- Line Stock id 130

o 19207_12422476-001
4 Pipe Set Startid 133 4

.7 Pipe To Point id 134 /

/7 Pipe Btend id 136

27 Pipe To Point id 142

.77 Pipe To Point id 148

B~ 19207_12423246-6808_P PRT

‘o Insert Here

FIGURE 25: SAMPLE PRO/PIPING DRAWING TREE
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8.6 Pipe Centerlines

The centerline for pipes shall be layered off in the drawing. This can be accomplished by
creating a new layer titled PIPING_BLANKED_LAYER or by placing them on the DTM_CURVES
layer.

8.7 Schematics

Schematics are required for any complex piping installation

ing and shall follow the

naming convention below;
CageCode_PartNumber

Example:
19207_12505846.dgm
19207_12505846.rsd

A complex piping installation drawi ntaining more than five piping

Ilation. Those piping drawings of insufficient
complexity should have the0Ip i ation defined in the installation drawing rather

in the notes on the installation el . RAM or Routed System Designer (RSD) may be

used to create th iC. ematic is not required to be parametrically linked to the piping

e Schematic Line Connection List; see Figure 26
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SCHEMATIC LINE COMWECTION LIST (COMPONENT REFERENCE DESIGNATORS, PORTS, CIRCUITS AND COLORSY - SORTED BY LINE NG
LINE INSTALLED | SCHEMATIC SIZE FRGM T2 CIRCULT LINE MATERIAL | FROM/TO LOCATION
NO LINE COLOR | LINE COLOR mm REF_DES PORT |REF_DES PORT PART NUMBER SH, VX

00| BLACK VIOLET 6.350 Dig 1.7 AT 1L AU TLTARY 12420572-004 SHE.F6  SH6.GB
ooz BLACK VIOLET 6.350 AL 2ACF oz 1.7 AURTLTARY 12420572-004 SHE,HE  SH6.F6
un4 BLACK BLACH £.330 C03 4.8 c02 4L CHARGING 124205072-004 SHo. A6 SHS,BY
uns BLACK VIOLET £.350 B0z 1.8 o4 1T AUKTLTARY 12420572-004 SHE F&  SHE,BS
00é BLACK BLACK 6. 350 C0¢ 4R Fo2 1R CHARGING 12420572-004 SHS, BT SHS. Ch
0o BLACK YIOLET &350 K2l 2R Al O1CR AUXTLTARY 12420572-004 SHE,G6  SH6, HE
Kl BLACK VIOLET §.350 <04 IB_R Al 1L AUXILTARY 12420572-004 SH5.05  SHE.CSH
nls BLACK GREEN §.350 ADI IB_R Cl3 IB_F REAR BRAKE 12420572-004 SH5.G8  SHS5 . HT
Ulg BLACK ORANGE 6350 ADI TACR Cl3 TAF FRONT BRAKE 12420572-004 SH5,H&  SH5 . HT
1z BLACK RED 9.525 ADZ Z2B.B o5 1.7 TRAILER SUPPLY SHo. 67 SHS.HT
103 BLACK TELLOW 5.525 ADZ 24.B A2d 1R PARK BRAKE SHa,G7 5HS,68

FIGURE 26: SAMPLE SCHEMATIC LINE CONNECTION

e Symbol Legend; see Figure 27.

SYMBOL LEGEND,

1T
505
1.E 2_B
N
4_H
02 e
PHEUMATIC-HYDRAUL 1 CONVERTER AlR DRYER
REF _BES: BOI - BO2 REF _DES: (0%
. am; see Figure 28.
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COLOR LEGEND

APPLICATON INSTALLED SCHEMATIC COLOR LINE
OR CIRCUIT COLOR COLOR APPEARANCE
CHARGING SYSTEM BLACK BLACK
REAR BRAKES BLACK GREEN
FRONT BRAKES BLACK ORANGE ——
PARKING BRAKES BLACK YELLOW
TRATLER SUPPLY/EMER. BLACK RED

TRATLER CONTROL/SERV. BLACK BLUE
AUXTLTARY AND CTI3S BLACK VIOLET
HEAT-SENSITTIVE STATHLESS GREY
VENT OR PILOT LINE BLACK BLACK-DAS —

HYDRAULIC BRAKE L INE BLACK PIN

FIGURE 28: COLOR LEGE AMPLE

e Piping diagram; see Figure 29.

27

)

DRAIN/FILL

FIGURE 29: SAMPLE PIPING DIAGRAM
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Installation drawings that do not have associated schematics should include a Line Connection
List in the installation drawing. This list defines the circuit ID for the routed pipes within the

installation.

Note: All circuits are labeled with proper identification numbers as described in section 8.3, table 11 and

components (symbols) are labeled with required reference designators that ¢ spond with Figures 24

and 25.
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8.8 Piping Checklists
Pro Piping Checklist

Piping Assembly

File Name: CageCode_ PipeAssyNo-6XXX.asm
The circuit identification matches the specific type of hose or tubing designated on the required circuit

number table. Refer to section 14.3, table 22

The correct line stock has been used.
The correct layers have been created in the assembly following the m ndards
All unnecessary layers are hidden in the assembly

The assembly was created using the correct start assembly.
There are no external references
Piping parameters (PIPING_ASSY, HOSE_LENGTH _ ENGTH, PART_NUMBER) to be
filled out properly.
The correct assembly structure was used, foll@wi ipi eling standards
Is the unit weight accurate and reasonable f@
Appropriate parameters have been completed

Model check has been comple

oDoogoono O gooogod g g

Centerline has been layer

i)
o
U
o
—

File Namg

All unnecessary 2 hidden in the part

Material file should n@t be called out

Is the unit weight accurate and reasonable for the pipe part
Appropriate parameters have been completed

The piping part was created using the correct start part

The correct layers have been created in the part following the modeling standards

Dodogooodogood

Model check has been completed for this part.
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Diagram Checklist

Sheet Setup

[] Correct format (e_fmtv_diag_1_2.frm)

[l Appropriate parameters for the diagram are completed

[] File Name is CageCode_PartNo.dgm or CageCode_PartNo.rsd
[] Nomenclature 3 is set to “SCHEMATIC”

[] Scale setto NONE

[l Weight set to -----

[] Diagram has been checked for spelling errors

] All Layers are hidden.

Tables

[] Textin table cells is visible, column with is

Notes and Revision Block

Required Diagram Notes ha

OoO0dooaod

A. ASME Y14.100-2€
B. ASME Y14.5-2009

2. SCHEMATIC IS IAW DRAWING 19207_XXXXXXXX
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A Modeling Best Practices

A.1 Part Mode

o Name features appropriately.
e Patterns and pattern table use is recommended
e Sheetmetal parts shall always be created by starting with the standard fmtv_start_shtml_part.prt

start part.

e Save models early and often.

e Base features should be kept simple.

e Sketches should be kept simple.

e Incomplete features must be removed or comple
¢ Relations should be clearly commented.
¢ Round/chamfer edges should generally not be used as ences for other features.

e Rounds and chamfers should be creatt

A.2 Drawing Mode
e Standard FMTYV formats (in Standard CAD Template Library) must be used on drawings. The
correct standard format version depends on the work effort.
e Standard drawing setup files (.dtl) must be used. These are applied when the appropriate

Drawing Options are used.

FMTV-MODELING-STD-100T Rev.L Pag e’/1 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

e Snapshots should not be used unless absolutely necessary.

o Drawings shall not contain overwritten dimensions unless required. For more information see
the Poor Modeling Practices in Appendix B.

e Views should be oriented using saved views or default datums, not model geometry.

« All notes symbols, and other 2D sketched entities should be related to the appropriate view or
object. (HINT: To check for this move the view(s) to see that no entities of the view are left

behind.)

A.3 Assembly Mode

e The first component or skeleton is the structural bas assembling all oth
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B Poor Modeling Practices

The following section explains how to avoid/work around several examples of poor modeling

practice.

B.1 Buried Features
Filling in holes/cuts with a protrusion is not acceptable. Occasion 0delCHECK reports

within the existing solid.

cuts as buried features if the definition of the subtracted volume lies enti

This is an allowable buried feature.

B.2 Overwritten Dimensions

It is not acceptable to overwrite a dimension

al to the material thickness of the part, the feature does not

update as des i idlthickness is increased. If thru all were to be set as the defined feature

B.4 Excess Datums/Features

Extra, unused datums shall be cleaned up/removed from models. When modeling a part or
assembly, datums are created for construction of the part. Often some of these datums are not actually
required in the final iteration of the model. These datums shall be removed when possible. Remaining

features shall then be named as appropriate (i.e. naming a datum plane CL_PART if this is the intent).
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When a part datum is to be used for assembly purposes, be sure to name it so as to recognize its
purpose and to avoid accidental deletion. (i.e. ASSY_1)

B.5 View Name and Scale Not Parametric
The displayed view name and scale should be parametric to the model. If these are accidentally

removed at some point, attempt to “show” them in the drawing instead of J@ying in non-associative

text.

B.6 Bending Back Using the Wrong Sheet
Be sure after creating an unbend feature to use th ect surface when creatingrthe bend back

feature. If the same surface is not selected, dimensions properly on the drawing.

B.7 “0” Offset Assembly Mate
Unless an assembly constraint of Mate he value of zero to make the design

flexible, it should be fixed as Coincident.

B.9 Flat patter@for Sheetmetal parts

Sheetmetal parts should not be created by starting with a flat pattern. Sheetmetal parts should
be modeled in an “as designed”, functional state. The flat pattern is created last (as necessary) for
manufacturing purposes, using Edit>Setup within the sheetmetal application. This creates a separate
flat instance which can be added to the drawing as a model independent from the generic fully formed

model used on all other views. The fully formed generic model may be changed and features added or
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deleted. As long as the family table is verified regularly, the flat patter will automatically update with
the changes done to the generic.
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C Miscellaneous Topics, Methods and Techniques

C.1 Model Relations

Each model has relations that can be found in part, feature, and sketch levels. Feature relations
take precedence over part relations as they occur later in the regeneration cycle. Relations found in

feature CSO/ACSO0 of the FMTYV start parts are required. These should not be changed from what is

contained in the start part.

C.2 Assembly Relations
(d#:# or d#:cid_#)

When part dimension symbols are shown in ass ey contain two numbers (d#:#).

The first number is assigned from within the part and is me number that will be seen if the

symbol was viewed from Part mode. The set mber is assi rom within Assembly mode and
econd number can also be found by
pox. Creo Parametric will return, Component

<component_name> has Se . Ea e assembly is assigned a unique second number

component is assemble ice in the same assembly. This method would be preferred if the same
component is assembled twice in the same assembly, a relation is written using the dimensions of the
component and then one of the components is replaced using Edit > Replace. Using the Internal

Component ID will ensure that the relation will update as intended.
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C.3 PROGRAM - From File vs From Model

The From File menu selection will be displayed only if the original PROGRAM has been
modified and there is text file of the program residing in the current working directory. If From File is
chosen, the editor will display the most recent listing of the program that resides on the local disk.

The From Model menu selection will extract the current listing associated with the object.

Upon initial creation of a PROGRAM, the user will not see these two choi€es, as Creo Parametric will

use the default listing associated with the model. After modifyin | file, then storing it to
disk, the user will be asked if he or she wishes to incorpo If the changes are

ill be deleted,

successfully incorporated, the model will be update acco y and the design

once again leaving only the default model listing.

C.4 Creo Parametric Layers

Layers are helpful in controlling the ¢
Parametric environment. Entities a i ) G ayer display status is set. Entities
created when using the FMT a automatically set to the appropriate layer. The two

exceptions are cross sectigada : atum planes. Additional layers may be created

often useful as explal he datum target point example described in the following paragraph.

An entity may be set to more than one layer. This should be done as little as possible since the
only way to see the entity is to turn on all of the layers it resides on or to set one of them to isolate
status. For example, if an item is on two or more layers and any one of them has a hidden status, the
item will not be displayed. If a point feature is placed on three different layers (dtm_points,
inspection_points, and datum_target_points) the datum target points may be seen by settings the

datum_target_points layer status to isolate.
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NOTE: Setting the layer to isolate status displays entities on the layer regardless of the layer status of

other layers it resides in.

The following image shows the layers found in the FMTV start part. Note that the display

status is hidden for all layers. This is how archived objects are set so that the screen is not cluttered.

b (%64

[ Shgw.v ][ La:-,er*][ Settings ™

= Layers

----- s Hidden tems
a DTM_AXES
E}-E DTM_C5Y5S
E DTM_CURVES
}E DTM_PLAMES

Unhide
Isolate

Activate

Deactivate

Save Status

..... Reset Status

..... Mew Layer...
..... Rename
""" Layer Properties...
FIGURE 31: SETTING VISIBILITY OF LAYERS
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It is acceptable to have layers unhidden as long as the config.pro and config.sup options listed
in FMTV Creo Configuration Settings prevent the screen from being cluttered upon initial retrieval of

a part, assembly, or drawing.

If a feature(s) on a layer(s), such as those generated by datum curves or a set datum operation,

displays despite these options being set then those layers must be hidden he feature in question

must be moved to a layer that is controlled by the above config.pro opti

C.5 Geometric Dimensioning and Tol T) used i Creo
Parametric

Geom T0
w GEOM TOL

Set Datum
Basic Dim
Inspect Dim
Specify Tol
Clear

Done/Return

FIGURE 32: INITIATEGTOL

Step 1 - Identify existing datums (or create new ones) to be used in constructing the datum
reference plane. Set the appropriate datums using the Set Datum command from the menu

above.
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Step 2 - Specify dimensions as basic as required. These dimensions made basic by using the
Basic Dim command from the menu above.

Step 3 - Specify dimensions as inspection as required. These dimensions made inspection by
using the Inspect Dim command from the menu above.

Step 4 - Describe features of size (such as holes and slots) with a feature control frame. The

the menu above. The

feature control frame is created using the Specify Tol command

geometric tolerance window appears as shown below. Sele button of the appropriate

FIGURE 33: GTOL MODEL REFERENCES TAB

Click the Datum Refs tab and then select appropriate primary, secondary, and tertiary datums

as references (if required). Make sure to set the proper material condition also.
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~,

O Geometric Tolerance

Datum References

Model Refs | Datum Refs IT"'l Value " Symbals | K

[] Unordered

Primary |Sv.=:1::u::nr1u::|E|r;.r || Tertiary | New Giol

Basic | rone

Compound | none

[ ] Composite Tolerance

~olsiNDio]
Sie DRI

REF STATUS: incomplete, please choose model and/or reference entity in

FIGURE 34: GTOL DATUM

Click the Tol Value tab and enter th

if required.

‘[ Geometric Tolerance

FIGURE 35: GTOL TOLERANCE VALUE TAB

Finally, click the Symbols tab and select any required symbols, modifiers, additional text, or

projected tolerance descriptors.

FMTV-MODELING-STD-100T Rev.L

Page 82

13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

[} Geometric Tolerance
— || 7| Model Refs | Datum Refs | Tol Value | Symbols | g
Symbols and Modifiers
O /{:}/ i [ ] Additionial Text on right
ﬁ Q [ ] {&T; Statistical Tolerance
[ ] & Diameter Symbol
sl J_ Projected Tolerance Zone
e [ 1 Free State
R [] 2 Al Around Symbol (& fores
| = ) Below Gtol
@ S— [] @ Tangent Plane ) Inside Gtol
/,g y [] Set Boundary
REF STATUS: incomplete, please choose model and.for reference entity inAModel Refs".

FIGURE 36: GTOL S

C.6 Datum Planes and GTOL

Datum planes will not appgak. i i ible datims to reference in the Datum Refs
portion of the Geometric Tole ss they have been set. To set a datum, select Set
Datum from the GEOM r plane to set, and then choose the placement
type for the datum from tie Ee or In Dim). Once the datum is set, it will be
available for referenei plane must also exist and be stored in the model showing the

Model field of of the Geometric Tolerance dialog box.

C.7 GTOL Datum Features Visibility

By default, all set datums will be displayed regardless of the existing display setting for datum
planes. This is true in parts, assemblies and drawings. For parts and assemblies, the only way to
remove the set datum is to place the datum on a layer and hide the layer. This is why it is required that

the modeler assigns set GTOL datums to the g_dtm_planes layer so that they may be turned off while
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modeling. In drawings, the set datums may either be turned off using the layer controls or erased using
the View > Show/Erase > Erase > Datum > Selected Item command.

C.8 ModelCHECK Process

ModelCHECK is used to compare the active part, assembly, or drawing to a set of required

configuration settings and report back items that are not set properly. It pr s tools to help correct

the deficiencies.

C.8.1 ModelCHECK Procedures

ModelCHECK will be run interactively in c session by each individual

designer. The designer will perform the task on each mod g he or she has worked on. Report
viewing will be accomplished using the bui Run ModelCHECK by

either clicking on the ModelCHECK Interacti sis pull down menu in the pull

Feasibility /Optimization...
Multi-Objective Design Study...

ModelCHECK. »  ModelCHECK Interactive
Compare Part 3 ModelCHECK Regenerate
ModelCHECK Rule Check
Configure ModelCHECK

ModelCHECK Geometry Check

i Saved Analysis
g, Hide Al

Delete Al

FIGURE 37: INITIATING MODELCHECK

A report summary will appear in the browser window that will look similar to Figure 38.
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@ Browser

L < BERA RS = N =
Address |F|Ie:ffﬂN:fModeICHECKfmc_reportsﬂﬂ?ﬂ?J2419131-4}02.p.l'rtml M 6) Go

[

PTC Model CHECK

= Model: 19207_12419131-002.prt I_.;: Status: O
Date: Thu Feb 24 2005 13:56:33

Mode: Interactive

Config: check/fmtv.mch, start/fmtv_met.mcs, co

Checked by: DAMI BrnjacR

Last saved by: DAMI_BRNJACR - Pro/E v. 2500 b
Creation date: Feb 10 2005

W&o

Check ¥
A\ Early Rounds
2 | 0, Features with Edge References

-

<

In order to view the information, click on the tabs at the top of the browser (Info,

Param, d Misc). By default only errors and warnings are displayed.
In order t tion and checks the check boxes next to the icons must be selected, as
shown in Figurens t to the icons show the number of related items).
Warning Info Pass
V@0 Fa2 i1 @23
FIGURE 39: MODELCHECK TYPES
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S - ABRARY %
Address | file:///W-/ModelCHECK/mc_reports/19207_12419131-002,p html & Go

PTC ModelCH

~ Model: 19207_12419131-002.prt % Status: @

Date: Thu Feb 24 2005 13:56:33
Mode: Interactive
Config: check/fmtv.mch, start/fmtv_met.

Checked by: DAMI_BrnjacR
Last saved by: DAMI_BRNJACR - Pro/E v
Creation date: Feb 10 2005

e Ld._‘:l"l:."[ T T LT
124 Layout Information

13/ Low Linear Talerance
1418 Minumum Maximum Linear
i) Model Name

19207 12419131-002.PR
59.00 x 39.00 x 59.00
30 [73.17%]

100

CAP. PRESSURE

US ARMY
VITY _LOCATION WARREN, MICHIGAM 48397-£

TAMK AUTOMOTIVE &
ARMAMENTS COMMAND

MODEL_REWV c

< 1 |

ACTIVITY

FIGURE 40: EXAMPLE OF MODELCHECK REPORT
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Clicking on any of the tabs makes that report page active. Clicking on the line number displays
a detailed description of the error or warning. Certain quick corrections, such as creating missing
layers and correcting layer status, can be made by ModelCHECK. It will take a few moments each
time a button is selected for the action to take place in the Creo Parametric session. After fixing all
errors run ModelCHECK again to make sure all items have been fixed. ModelCHECK will not save
the model or check it in to Commonspace; the user is required to complete those tasks when

appropriate.

be promoted in Windchill PDMLink. When ModelCHE

an error:

11. Unused drawing*sheets are not allowed.
12. Any dimensions in drawings that may not be regenerated are not allowed.
13. Drawing format must be current.

14. The ModelCHECK ignore function may not be used.

15. Relation Check
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Any checks resulting in a warning shall be investigated, as they are case dependant occurrences.

When ModelCHECK is run the following checks will result in a warning:

1. Model name shall be equal to ##### *. (Checks that the file name begin with five numbers
and an underscore).

Relation errors shall not exist.

In general, erased drawing views shall not exist.

Round children (features that are children of rounds) are not design best practice.

o &~ N

Overwritten dimensions in drawings are not advised as a drawing best ice. In certain

instances they are required though, such as when sho dimensions for ily table part

where values A, B, C, etc. are required.
6. Draft feature children are not normally a design b
7. DTL file settings shall match standard settings. If se tems don’t match the standard

settings, this may indicate that the wr

C.9 Geometry

Creo Parametric issue ometry check” warning when a model is regenerated to indicate

Examples of a reportédigeometry check include:

A geometry check warning of a tiny edge detected. The geometry check probably doesn’t
affect the model accuracy or a drawing of said model. Some risk is present regarding the export of
“clean data” There is also a small amount of risk that further design changes may put the model at risk
of failure.

1. Assess Risk:
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Factors that may be used to determine the risk associated with a geometry check include:
e Location
¢ Anticipation of Design Modifications
e The Use of Downstream Applications: Including the use of shared data features and the
export of model data for simulation, analysis, and manufacturing.

e Quality of Design Techniques:

2. Investigate solutions:
Alternatives for resolving geometry issues include:

o Redefine the affected feature so the Geometry This may be as

edge to a vertex in

simple as creating a Sketcher constraint to ali of having the

geometry driven by a dimension. In more e elements of the feature may
need to be redefined (for example, by makin d using Surf-Surf instead of Edge

Chain.)
o Create the geometry with a differe

referencing of existing geometry.

the references or shapes of the features involved.

possibility that the geometry has been created according to the

Choose the lent and appropriate solution from above.

C.10 Mapkeys
See FMTYV Creo Parametric Configuration Settings
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C.11 Symbols
Symbols are located in the Standard CAD Template Library / Symbols. They will also appear

in the default User Symbol directory in Creo Parametric. The list of available symbols in
Commonspace can grow as more are created. Separate sites can also create their own specific symbols

and stored outside of Commonspace if so desired.

C.12 Skeletons and Assemblies
C.12.1  Scope

and coordinate systems but no solid features. The ske ve a base coordinate system that
corresponds with the vehicle coordinate system (Refer to i . The addition of multiple
skeletons to build complete vehicle configurati . ns will generally look like a 2D
or 3D *“stick figure” sketch with many point inate Systems. The skeleton needs to

have the necessary information to 1o¢ca

all contain a coordinate system corresponding with the vehicle three
dimensional refere ich is oriented with the ‘X direction running along the centerline of
the vehicle with “+ ing rearward, “+y” going to the curbside and “+z” going up.

The installation'odel should be built on a skeleton with the primary components tied directly
to the skeleton. Sub-components that attach to a primary component will be mated to that primary
component. For example: a bracket assembly that mounts to the frame will be assembled with
skeleton constraints while the hardware and other components mounted to the bracket assembly will be

mated using assembly constraints to the bracket assembly.
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The skeleton constraint shall be a coordinate system (CS) created for a unique component and
renamed in the model tree as “part number” for that particular component. If more than one
component of the same name will exist in the same skeleton, either rename the CS with the part
number followed by consecutive numbers (part number-2) or if it is a symmetrical application, use -LH
or -RH behind the part number. By constraining the coordinate systems at assembly the component

will be in the correct location in the assembly.

It is essential to have a corresponding coordinate point in the onent being assembled to

the skeleton. The desired coordinate system for the component default CSO so that

The coordinate system for a component must be made to a e on the component that is not likely

to move.

The creation of the coordinate system itional datum curves, axes, or datum

planes for proper creation. If sogiasboth the and the component, rename them so that a

modeler will not accidentally g e. Other information to keep in mind:

used in.
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C.12.3 Example of an Installation assembly using Skeletons:

//_\_ T —_—
,_::_““‘“=-=:?§4easss_nn
s \ !
e300 -boe A
& ﬁ h_"“‘)ﬁ./m. {/
o I\-H"“-———f""'/’ T 2nis338
A —— I)il_,
T Y iBa2sss.in
1)?_[ \\__ |

7 conn
~C300ss5y_csy

1

¥
I
12418337
1

_ ¥

FIGURE 42: 2D CURVES AND CSYS FOR ASSEMBLY
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S

A 0

CS in skeleton
assembly

FIGURE 43: |

% Component Placement
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— Component Reference

K | [19337: 12418337_assy_cssy
Agsembly Reference
’7k l’_123787DE-ED1 12418337

[ Placement Status

Fully Constrained

0K Freview Cancel

\ .

FIGURE 44: COMPONENT PLACEMENT DIALOG Box
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View of completed

assembly from the
top looking down at
the roadside of the
,y/

cab

it |
View of completed P
assembly from the N
bottom looking up s A
towards the roadside . T
of the cab -

FIGURE 46: REAR VIEW OF CAB ASSEMBLY
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FIGURE 48: COMPLETED DRAWING - CAB TOP VIEW
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C.13 Installation “Split Balloon” Find Number Technique
C.13.1 Scope

This is the required method of identifying components on an assembly or installation using the
parametric BOM in Creo Parametric. The split balloon has the Find Number on the upper hemisphere

and the Quantity on the lower hemisphere. Within Creo Parametric, the option for this balloon is “with

Qty” when selecting the balloon region. This technique allows compone h multiple instances to

maintain the total quantity in the BOM as the balloons are dissemi cross the drawing. The

balloon in each view or balloon location.
There is a command named split, which means t i ase balloon into separate balloons
and is not to be confused with the term split b
For reference part callouts on an as
identifying reference components. Use approp e parametric reference balloons as
if the reference item is from a component not

contained in the Bill of Ma | be used for reference.

FIGURE 49: REFERENCE BALLOON FORMAT
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C.13.2 Procedure

1. Retrieve the table sbpartslist.tbl (or sbpartslist_spec.tbl) into the drawing.

- Pro/EMGINEER
Sketch Table Format Analysis Info Applications Tools Window FMTV - Mapkeys
= [ = | e
Insert k¥  Table § %{.- —q
A Table From File... =

o

|Insert a table by retrieving a file

OD:V:

FIGURE 50: STEPS TO

The left
column is for
the Find No.

ART NUMBER DESCRIPTION CAGE CODE
/ PARTS LIST
/ FIGURE 51: SPLIT BALLOON TABLE
The upper The lower
hemisphere hemisphere
identifies the identifies the
FIND NO. Quantity
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2. The Parts List Table will automatically fill out with the contents of the BOM.

20 \ 12423650 WASHER, PLAIN 19207
19 3 12417975-006 WASHER, FLAT 19207
18 \ 12473649 SCREW, MUSHROOM HEAD 19207
17 \ 12418338 PANEL, INTERIOR, VEHICULAR, RIGHT SIDEWALL 19207
16 ] 12414475-01 | WASHER, PLAIN 19207
15 \ 12418337 PANEL, INTERIOR. VEHICULAR LEFT SIDEWALL 19207
4 \ 124722875-013 HEADL INER, RH PANEL ASSEMBLY 19207
13 \ 12422875-003 HEADL INER, HATCH COVER ASSEMBLY
|? \ 1242287501 | HEADL INER, LH PANEL ASSEMBLY
N 43 [ 12422873-002 FASTENER, HEADLINER
10 3 [2422875%-00 | FASTENER, HEADLIMNER
g 2 12422885 DAMP ING PAD
8 Il 12418469 RIVET, COMPRESSICN
7 I8 |12422874 CLIP, HEADLINER
B 16 |12422884-007 BUSHING, SELF- LOCKI
5 ] 12422884001 BUSHING, SELF- LO
4 2 12423075 ANGLE, REINFORCEME 19207
3 2 12422675 TAPE, DOUBLE SIDED B A0mm LONG 19207
P ] 12422675 TAPE, DOUBLE SIDED BOND 19207
| 7 [2414419-076 SCREW, 19207
FIND
NO @w PART NUMBER CAGE CODE
C.13.3 Split Ba
The split balloons a
Table > BOM with Qty and select the Parts List table region, and then Done.
Go to the the Tables > BOM Balloon tab select Show and select the
primary vie
To divide p into smaller quantities, (while still in the BOM Balloon drop-down

menu) select the spli and and select the balloon to be divided, and enter the amount to be taken
out of the total quantity from the base balloon. Then at the prompt, select the new component location
to have the balloon and pick the location for that balloon.

This portion of the procedure is the same for other methods, but the quantity remains visible and

parametric to the system generated BOM table.
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From this point, the balloon manipulation sequences (detach, merge and redistribute) work the
same as other balloon methods.

Example of Split Balloon callouts for the table shown in Figure 53 below:

DRIVER"S 310

ATRYU NN

: % NARKEL &
(50
WIS

WARKED s
B
N

{HMARKED F

mms[u B}

iy
W1
PASSLNGER 'S $IDE

FIGURE 53: EXAMPLE OF SPLIT BALLOONS ON DRAWING

C.13.4 Split Balloon Callout for Multi-Configuration BOM Report Table

In a Creo Parametric drawing, an assembly drawing format can be modified so the BOM

Report Table reflects multiple configurations of an assembly. This can be based either on family table
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instances or separate assemblies. The preferred method is to create multiple BOM tables with each
instance having its own table.
C.13.5 Split Balloon Callout for Bulk Items

Bulk material items such as convoluted tubing, strip foam seal tapes and other items that are cut to
different lengths and have possible different installed state models but have the same part number need
to be shown in the PARTS LIST TABLE as a single Find Number. In order
required, including relations in the PARTS LIST and created split balloo

this, several steps are

3) A relation is written against the Parts List T th of the bulk
item
4) The split balloons for the filtered find numbers d (dummy) using the Find Number

of the totaled bulk item still in the Parts List

18207
19207
| 9207
| 5207

VUL UTED | 8207
e, CONVOLUTED | 9207
P, TIEDOWN, ELEC COMP, ADJUSTABLE, SELF CLINCHING, PLASTIC, TYPE I, CLASS 81343
TIEDOWN, ELEC COMP, ADJUSTABLE, SELF CLINCHING, PLASTIC, TYPE 1, CLASS B1343
19207

| 1 Z420924-008-800
48 ? 12420924-007-605

| F

|

|

|

12420924-008-5
|2420924-007-
12420924-005
12420824-008
43 11 [M33367-35

sizes were totaled up ARTS LIST for the quantity.

45 24 IN |12420924-005 TUBING CONVOLUTED 19201
44 33 IN |12420824-008 TUBING, CONVOLUTED 19207
43 |1 |M§3367-3-0 STRAP, TIEDOWN, ELEC COMP, ADJUSTABLE, SELF CLINCHING, PLASTIC, TYPE I, CLASS 81343
42 12 |M§3367-2-0 STRAP, TIEDOWN, ELEC COMP, ADJUSTABLE, SELF CLINCHING, PLASTIC, TYPE |, CLASS 81343
1] 42 IN | 12420824-007 TUBING, COMVOLUTED 19207

FIGURE 55: FILTERED BOM FOR BULK TUBING

The cut length for each item is identified next to the split balloon at each location in the installation.
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12 MY ENGTH = 9 I

L
|

EARD  TO MHE HAND PUMP

LENGTH = 24 [N

FIGURE 56: BULK LENGTH DEFINE IN VIEWS
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The split balloon callouts for the 41, 44 and 45 find numbers were created with a symbol since these
belonged to the filtered out find numbers. The software cannot generate the balloons for these items so
the balloon symbols have to be used. (NOTE: The symbol may be called BOM_SPLIT_BALLOON
also in the Library)

Custom Drawing Symbol

General |Gmuping I Variable Text |
— Definition
Symbaol namel SPLIT_BALLOON x|

X

— Previg

— Placement
Type I Free j
[ext Ieaderl j Amowhead | Amow

— Properties

Height IE.EEEEEE
Propartion I

Angle 0.000000

1

Color

IGURE 57: SPLIT BALLOON SYMBOL

1) The quan split balloon shall be 1 and the cut length designated either beside or
below the ball@ e reason for this is to clarify the cut length for each item and to insure that

the correct item is used in the designated location.

2) The total length of the bulk material for all locations is indicated in the quantity column in the

Parts List along with the unit of measure as a relation to replace the actual unit quantity.
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10 ]

File Edit Insert Parameters Utiities Show

Look In
I Region j _EII Region j

O Y B B X AR || -0 R

+
— [if final_name == "12420524-008"
« [ty = "33 IN"
; elze

; if final_name == "12420524-005"
C) fbghy ="24 IN"
[] |else

~ |if final_name == "12420524-007"
bty = "42 IN"
glse

if final_name == "MS533&7-2-0"
bty = "12"

else

—

58: RELAT

this, use onepof the ten available empty table space #.prt parts located in the Standard CAD

Template Libre Parts and Formats. The empty _table_space #.prt model is a bulk item

and a relation wil e to be written in the parts list on the drawing as shown below:

if asm_mbr_name == "EMPTY_TABLE_SPACE_1"

final_name =

tqty =
endif

FMTV-MODELING-STD-100T Rev.L Page 103 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

C.14 Creo Parametric pen table settings (default)
See FMTYV Creo Parametric Configuration Settings

C.15 PDF print settings
See FMTYV Creo Parametric Configuration Settings

C.16 PM-MTYV Default configuration file settings
See FMTYV Creo Parametric Configuration Settings

C.17 Annotation Features

Annotation features E are data features that can nnotation and
propagate model information to other models. An i ature consists of one or more
Annotation Elements. Each Annotation Element can ¢ one annotation item, along with
associated references and parameters. Th tations can be added using the

Annotation element:

e Note
e Symbol
e Surface finish

Geometric tolerance

selecting Tools > Relatons and then setting the type to Feature and then selecting the default
coordinate system CSO. Table 14, shown on the following page, lists the current state of relations for

the start parts.
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~

* START OF FMTV START PART RELATIONS

* DO NOT DELETE OR MODIFY ANY LINES IN THIS SECTION
* LAST MODIFIED: 30 NOV 2004

*

* RELATION TO COMBINE NOMENCLATURE LINES

*

-~ -~

~

nomenclature= nomenclature_1 + " " + nomenclature_2 + " " + nomenclature_3

[x

/* RELATIONS TO ASSIGN DESIGN ACTIVITY AND DESIGN ACTIVITY LOCATION

/* BASED ON CAGE_CODE

[x

AGENCY="US ARMY"

IF CAGE_CODE == "19200"
DESIGN_ACTIVITY="ARMAMENT RESEARCH, DEVELOPMENT AND ENGI
DESIGN_ACTIVITY_LOCATION ="PICATINNY ARSENAL, NEW JERSE 6-5000"

ENDIF

IF CAGE_CODE == "19204"
DESIGN_ACTIVITY="ROCK ISLAND ARSENAL"
DESIGN_ACTIVITY_LOCATION = "ROCK ISLAND, ILLIN

ENDIF

IF CAGE_CODE == "59678"
DESIGN_ACTIVITY="ARMAMENT RESEA
DESIGN_ACTIVITY_LOCATION ="RO

ENDIF

IF CAGE_CODE == "19207"
DESIGN_ACTIVITY="TANK AUTO
DESIGN_ACTIVITY_LO!

GINEERING CENTER"

MICHIGAN 48397-5000"

ENDIF

IF CAGE_COD
DESIGN_A SON TACTICAL VEHICLE SYSTEMS, LP"
DESIGN_ACT = 0 WEST, SEALY, TEXAS 77474"

ENDIF

if auto_part_number
/*
/* CHECKS FILE NAME LENGTH, LOCATION OF UNDERSCORE, LOCATION OF HYPHEN
/*
file_name= REL_MODEL_NAME()
under_loc = search(file_name," ")
dash_loc = search(file_name,"-")
file_len = string_length(file_name)

/*
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TABLE 13: START PART RELATIONS

C.19 CHECK mapkey

See FMTYV Creo Parametric Configuration Settings document
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C.20 Component Interface functionality

Component interface functionality was added in Creo Parametric Wildfire. They contain a set
of stored constraints and references that can be used repeatedly to place components. Once an
interface is defined and saved in a component, it can be used anytime the component is placed in the

assembly. Placement of components using interfaces allows them to be constrained more efficiently.

Currently Component Interfaces are not defined on any of the parts. If a needs to assemble the

same component many times they can create a Component Interface o “In-Session” model. By

adding the Component Interfaces “In-Session” and using it at that tj as they don’t save the
component, it will not affect the model. These Component Int ed in both Part and

Assembly mode.

C.21 AUTO_PART_NUMBER functiona

The AUTO_PART_NUMBER para
set to YES then the model automaticall
PART_NUMBER parameter. If it is set to NO'the pty and the user is required to enter

to the start parts. If the value is
part and assigns it to the

model. 3 ed to “ITEM_ID”, and it shall be added to the “ITEM_ID” layer so

shall be the ACTUAL

the text on the drawing.

M ID that would be marked on the part. A sketch feature can be used to get

C.23 Mass Properties — Manual Input
In certain cases it is helpful to be able to enter the mass of a model manually. Typically Creo

Parametric will calculate the mass of the model automatically based on the assigned density and the

FMTV-MODELING-STD-100T Rev.L Page 107 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

calculated volume. Often times when dealing with purchased parts or where the material properties
aren’t exactly known, it is helpful to be able to add the final mass manually. In order to complete the
task select Edit > Setup > Mass Props then choose Geometry and Parameters as the Source. Then
choose Edit from the Actions area and enter in value for Mass. This value becomes known as the
PRO_ALT_MP_MASS parameter.

@ Setup Mass Properties

Source

| Geometry and Parameters

Crigin
| & | Defaut

R
0.000003
Actions
|  Edi. ||Generste R

FIGURE 60: MASS PROPERTIES PARAMETER

C.24 Military parts and Vendor parts

Typically, military parts are recognized by either the name of the file or by having a
CAGE_CODE parameter filled out. Below is a list of typical military part numbers (either 7 or 8
digits in length) they can either have the cage code preceding the name or only as a value for the

parameter.
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o 12XXXXXX

o 116XXXXX

e 87txxxx (top drawing)
o 57kxxxx (kit list)

If it doesn’t meet the above criteria it could be a vendor supplied model; however, there are

exceptions so this will need to be verified.

C.25 Vendor supplied 3D models
The way to handle vendor supplied 3D models has ch
maintain the vendor’s naming convention so when new

updated in Commonspace.

them into Creo Parametric. Factors that affec

* Original CAD syste
* Quality of mod
* Model accuracy
* Model i

geometry. The convegsion to solid models helps ensure that proper model display and mass
calculations can be made. If the task of converting the imported geometry from surfaces to solids is
beyond the ability of the modeler then a modeler with the appropriate ability should be tasked with

converting the model.

The neutral file shall be stored in the FMTV Product under the Models and
Drawings/OEM_Models folder in Windchill PDMLink
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C.26 Next Assembly Parameter

There have been issues with the next assembly parameters with some parts that are in
Commonspace. The NEXT_ASSY parameter shall represent the assembly where the part is used. The
problem is mainly found with parts (ex: -001, -501, and -801) where the next assembly parameter has

been filled out incorrectly.

[T] 19207_12222221.ASM FRAME ASS

=-{T] 19207_12345678.A5M -WELDME
-] 19207_12345678-001 PRT
----- [ 15207 _12345678-002 PRT
..[] 19207_12345678-003.PRT

FIGURE 61: ASSEMBLY STRUCTU

The left-plate, right-plate, and center-
occasions it has been noted that the NEXT_AS plates has not been 12345678, it
has been 12222221 (Frame Ass ply is the up assembly in which the weldment is
assembled. The plates shall » t assembly. The weldment shall have 12222221

numerically.

NEXT_ASSY_1 12401111

NEXT_ASSY_2 12402222
NEXT_AS5Y_3 12403333
NEXT_ASSY_4

FIGURE 62: NEXT ASSEMBLY LIST

In situations where there are more than eight up assemblies, do not create additional
NEXT_ASSY parameters. For the drawing, a hex note can be placed in the NEXT_ASSY parameter
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box located in the title block to relate back to the drawing notes. The drawing note will list all of the

next assemblies used.

The next assembly parameter is based on the assembly that a part or assembly is configured
into. A Where-Used Report can be run in Windchill PDMLink to show what assemblies a part or

assembly may be a component of.

C.27 Handling a Cancelled ECP

Occasionally after initiating an ECP that involves chan

in the future, and it is not cost effective t

dictate how to deal with these objects.

e If the objects are the INITLA

the Release Level sha

e If the previous R

C.28 Keep All Down Parts and Drawing at Same Revision when
Promoting

There have been many issues related to not keeping the same base number components at the
same revision level. The base number refers to the 8 digit number after the cage code and underscore

in the name of the object. The rule is that all components with the same base number must be revised
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when the drawing is revised. If drawing 19207_12341234.drw is being promoted to a new revision
then all models beginning with 19207 12341234 shall be promoted along with the drawing unless
noted on the NOR. An exception is when in the newer revision one or more of the components are no
longer required and those can remain at the previous revision. All of these components shall be related

to the drawing even if there are no views describing the individual components.

C.29 Weldments
All weldment component parts shall follow the -100 namin (as defined in Section
3.8) for the inseparable assembly. In addition, the PARTS L ment shall specify

“NON-REPAIRABLE PARTS LIST” (See Figure 63)

5 | [2423058-105 192071
4 | [2423058-104 (9207
3 Z [2423058-103 [9207
¢ a [2423056-107 19207
| | [2423058-10] 19207
FIND v .
N m P SER DESCRIPTION CAGE CODE
JLE PARTS LIST
DMENT PARTS LIST
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D Procedures

D.1 Creating a new file
The following procedure shall be used whenever creating a new model. This will ensure
conformance to the latest standards and will allow the models to be tracked by Windchill PDMLink.

This is very import in order to avoid any duplication of work.

1. AIlI NEW parts shall be created with the approved FMTV start
2. All required parameters shall be filled out before checking fi monspace
e ECP_ERR_Number is important to know what E file

D.2 Family Table Drawing Creation
D.2.1 Creating the Family Table in the Part:

del the part. Each instance will
pumber with a 19207 _ prefix. The
able to correctly show the part number in the
drawing table. Additional par, to correctly represent the model at different part
levels. Include any techni i i s, i.e.. din_number or thread_size.

amily Table functionality with Creo Parametric
e them when it makes sense. In order to decide when to use a

family table i i I ing many models follow these general guidelines or ask a local

amily Tables ever. They will cause problems with the database

management syste

D.2.2 Auto Fill Instructions:

The family table can be filled out quickly by exporting the data to Microsoft Excel using the

following icon E{ . Use the Fill > Series command to automatically complete column. Make sure
the column to be filled is empty and then highlight the area to be filled. From the top pull down menu
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select: Edit > Fill > Series > Set Type to AutoFill and select OK. Once this is complete, the family

table should look like the following figure:

" Family Table :19207_12345678 ﬂ
File Edt Insert Tools |
Lnnk|n;|1azn?_12345s?a j

d2 dd d1 FPART_MLU DIMN_MUMBER

Twpe | Inztance Mame

13207_12345678 1.0 15 20 1-1.5-2-blk - 100
13207_12345673-001 20 2.0 4.0 2-2-4 - Bk - 100
13207_12345678-002 3.0 25 3-2.5-6 - blk - 100

13207_12345678-003 4.0 an -blk - 100

d one empty row for the first field. Only create
e table. Some Family Table columns are used
pe shown in the drawing table.

——

4 WIDTH | GEPTH DIN MUNBER

2. Create simple repeat regions in all of the cells:
Table > Repeat Region > Add > Simple in each column, below the title, pick each of the

empty cells twice to create a repeat region.

3. In each column enter: &fam.inst.param.value. :

Enter Text > Report Sym select the cell to enter text fam... inst... param... value
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PART MNUMBER WIDTH | DEPTH DIN MUNBER

fam.inst.param,.vaoljue

4. Add a filter to each of the repeat regions to only show the values intended for that column.

For part number, create the filter: &fam.inst.param.name==part er.

Table > Repeat Region > Filters > Add &fam.inst.param.n arameter Name - Done

- Done/Return.

PART NUMBER WIDTH

| 2345678-001 ¢, 0 - blk - 100
23456 78-002 3.0 - blk - 100
| 2345678-003 4 - blk - 100

assembly
e Skeletons can be
e Clean BOM

e Can create a library of standard views

mbedded into the backdrops

e Useful during the design process as well.

Step 1 - Identification
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The following items should be considered when determining what the backdrop geometry will

be composed of:

e Determine the geometry and views necessary for the drawing.

e Build a temporary assembly model or use an existing assembly (using only the components that
will be seen).

e Avoid using any shrink-wraps in the model structure.

e Establish a known coordinate system location:

o For small installations with isolated components (c
general area), use the interface for the primary co
lightweight backdrop to serve as a skeleton as wel

nts located in the same
is method allows for the

o For large drawings with components spr use the default
coordinate system (A separate skeleton fil onents will be
required and the associated skeleton(s) vui i

Step 2 - Establish offset coordinate systems

Coordinate System

Reference Geometry

65: ESTABLISH OFFSET CSYS
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Imm x Imm curves on
outboard surface created on
top of Coordinate in the shape
of an “L” to help define
directions in a coordinate

system.

FIGURE 66: CREATE 2 - IMM X 1MM CURVES

Imm X Imm curves on
datum plane in front of
cross-member

%. ANOTHER 1MM X 1MM CURVE SET

e Create ane [ drawing, empty, with a variable sheet size at 1 x 1.
e The format is not required; make the border size small for ease of deletion later.
e The drawing has a base coordinate at the bottom left corner.
0 The location of the coordinate on the drawing will not work for lightweight backdrops

0 The coordinate curves created in the prior step will be used to create the assembly

coordinates in a later step.
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= Mew Drawing x|

— Default kM odel

IL.-'-‘-.EIEH DES-5071.A5M Browse. .. |

— Specifp Template

" Lze template

...............

— Orientation

Fortrait | Landscape

— Size
Standard Size I Al

¥ Inches
™ Millimeters

OM NEW DRAWING
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l Drawing Yiew . ll
Categories Wiew display options
View Type [T Use parent view stile
Visible Area £ 4
Scale Dizplay style | Default j
Sections
Yiew States Default
o - Tangent edg -
ELRIR £ wireframe
Qrigin Hidden line ) Colors come from
Alignment C Ves () Hidden

* The drawing

Mo Hidden @ it

& Mo

Skeleton model display
¢ Hide
" Show

‘weldment #2ection display

Close | Anply |
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Step 3b — Inspection of Lines

o Notice the hidden lines for the steering gear casing.

e This was an imported model and will not clean up well, so either eliminate from the

assembly or replace with a true model.

.....

FIGURE 70: INSPECT LINES
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Step 3c — Make other Views

e Do not make projected views or auxiliary views; make only one view at a time.

e After each view is created, save as a DXF file, using the -8xx series of pames.

Modal
HewHare [T747cecr i3
8 [T

[T i

FIGURE 71: MAKE OTHER VIEWS
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Step 4a — Make the Backdrop

e Start a new part file with an appropriate name utilizing the -800 series.

e Import the DXF file: Insert > Shared Data > From File

e Follow all the defaults:

B 1242X%NXE-801 (Active) - Pro/ENGINEER

~u " Hale..
lpsa g
go %l P R,
Show ¥ | 5, ﬂ_\ Draft, ..
m "\;Rgund...
oo Chamfer r

r';f," Extrude. ..
o Revolve. ..
Sweep
Blend

Swept Blend

dent Geomekry, ..

User-Defined Feature, ..

Fareign Surface, ..,

From File...

Advanced Publish Gearmetry. ..

Copy Geometry from Other Model...
Shrinkwrap From Other Model. ..
Merge from Other Model, .,

Cubout From Gther Model, .
Inheritance from Cther Madel,..

FIGURE 72: CREATE BACKDROP PARTS
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Step 4b — Coordinate System

e Create a coordinate system that corresponds to the assembly

e Use the two 2D curves to establish the coordinate

e Rename the coordinate to a common identifier.

=

v | e | Prcpme |
Pefemences

Curves FEIMPORTE_ On
CurveFEMPORTF.. On

& COORDINATE SYSTE x|

Origin ~ Orientation | Frnpeltlesl

Drient by
& References selection
€ Selected D575 aves

Use [ Curver ..
e | Sl [
Use [ CorverFEQM...
wodest [ 7] Fie |

Cancel

FIGURE 73: CREATE COORDINATE SYSTEM
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Step 5a — Cleanup

- Select the geometry and right click
- Then select Edit Definition

Delete

Suppress

Rename

¢
Hide
Edit Parameters
4: CLEANUP - EDIT DEFINITION
- Another menu will appea k
4
- Click on the arrow a ..,.r
the format and delete th X
need to be selected Jo: Sl
- Clean o
wanted ifithe drawing. ":f
r}
Ilﬂ..-"'
0 wx b

FIGURE 75: DELETE 4 FORMAT LINES
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Step 5b — Line Font

e While still in the edit mode, click Edit > Feature Operations > Modify Line Style and
then change the font to phantomfont and the color to light grey.

e The 2D lightweight backdrop is now complete.
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=l [ paste Grl+y, ZETE
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£ e .
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ﬁ il
“HSinersedt.,
p Bz

£ B Project,.. SIDE
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v FRONT
z i cso
;E Extend... ool
Bl afrecty p
-E
H|E Teken., et
70 Sl . i

~ ;Hxﬂ&ﬁ
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References :
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Pattern Table. .
Scale Mods|
Featurz Cperations

) 4“@“%5&“,*‘
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(K Eind.. CrrF
Hyperlink.
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RE 76: CHANGE LINE FONT
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FIGURE 77: COMPLETED LIGHTW, 2D BACK

Step 6 — Lightweight Assembly

Skel
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File Edit Yiew Insert Analysis Info  Applications Tools Plotting Window Help  FMTY Toals

lccogad|penairen | Drssaaasto@eo oo i il|~Hn
8o | & @ &R
Shgw'l Settings'l
LIMIT
124 23-800.45M 00000

----- 2 MoteO_DESIGMN_INTENT

"= DRW_NOTE
..... /7 SIDE_ASSY
..... /7 TOP_ASSY
..... /7 FRONT_ASSY

;{« ACS0
;{« E-HOLE

F- ) 12424444801 PRT 0.000¢
B 12424:444-802. PRT 0.0000k
E-( 12420400803 FRT | 0L000CF
----- P |nsert Here B

Step 7 — Insta

e Add the lightweight backdrop/skeleton models first
e Assemble the components in the assembly

e This is a clean assembly with no tag-along parts, other than a few models with reference
data
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TALLATION ASSEMBLY

Step 8a —

e Start the drawing and place views as normal
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80: BEGIN INSTALLATION DRAWING

Step 8b — Drawing Cleanup

e Set the drawing visibility to No Hidden

¢ Notice the phantom geometry is hidden out
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e Notice the lines of the other 2D views

RAWING CLEANUP
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Click View > Drawing Display > Component Display

e Edit | View Insert sketch Table Fomnat Analysis Info Applicstions Teck Floting window Help FITY Tooks

0y (3 e ST N E R R E e E A

Update

A R AT Y - IRy 1=
% Orientation

visibiliy

& I124; Show and Erase. .. =

Madel Grid....
Lacation &rid

AL bisplay Settings »
fEASSTToTS————————————— __ Drawing Visw visbility

-3 4S5Y_DATUMS Componert Display...
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-6 CURVES |
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FIGURE 82: INSTALLATIOND ENT DISPLAY
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FIGURE 83: INSTALLATION DRAWING CLEANUP -
BLANK COMPONENTS
Step 9 — Complete Drawing as Normal
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e This works for sections and auxiliary views also
e Write a relation to remove the Lightweight Backdrop / Skeleton assembly from the BOM

¢ Notice now the SOLID geometry pops out in front of the PHANTOM geometry.

SCALE 14

84: COMPLETED INSTALLATION DRAWING

Backdrop A ure — Reference Information

this section describe the methodology for creating the lightweight
backdrop parts, assemBly, and drawing. The method for assembling installation parts in upper

assemblies will be to create two assemblies rather than just one.

e The first will be the base assembly without any backdrop components assembled. (Example:
19207_12345678.asm) This Assembly will be used in upper assemblies so backdrops will not
be visible in these assemblies.
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e The second assembly will be used in the installation drawing and will have all of the backdrop
components assembled to it (Example: 19207 _12345678-800.asm). This Assembly will only
be used in the installation drawing. This will have all the -8xx backdrop parts assembled,
along with the base assembly. The Model Tree would look something like the image below.

(L] 19207_12345678-800.A5M
F-[Cd 19207_12345678.A5M

e Alternative Technique for Installation Drawi

parts. The -800 2D/3D backdrops

e All 2D backd s shall be LIGHT GREY in line color and PHANTOM in line style.

Using Parts Table in Installation Drawing

If a parametric parts table needs to be shown on the installation drawing, the recursive attribute
option will have to be used on the table to show the correct parts. Select the following commands:
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Table > Repeat Region > Flat/Rec Item and then picking the assembly that needs to be shown (the
base assembly). The -800.asm and the -80x (backdrop parts) will still need to be removed from the

parts table by either manually filtering them out or using a relation to filter them out.

D.4 3D Lightweight Backdrop Creation

This process is for creating 3D lightweight backdrops for use in

Ilation and Assembly

drawings as phantom reference geometry.

Advantages

e Dramatically reduce the file retrieval and regenerati
e Geometry is clean (other methods require a subs

clean-up)

e No tag-along parts (additional parts not used lation shall not be part of the

assembly)
e Skeletons can be embedded into the
e Clean BOM
o Useful during the design process as well!

Step 1 - Identification

ecessary geometry required to create the views
@ the user to have the necessary assemblies in their

kwrap model

The reate a new Creo Parametric part. This part will be given a -801 or
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— Sub-type
& Solid
" Compasite
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" Bulk
= Harness
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Common Mame

¥ Use default template
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FIGURE 86: CREATE 3D

Step 3 — Create Shared Data Feature

Select Insert > Shared Data > S
shown below.

ROP PART,

ap from reo Parametric main menu as

Eile Edit Yiew |Insert Analysi

J [ B’h E'LFHDIE...
Shiell.,.
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> Reval
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"B Insert Here

Independent Geometry..,

Data

Advanced

User-Defined Feature. ..
Eoreign Surface...

From File...
Publish Geormetry...
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hserts a shrinkwrap

FIGURE 87: CREATE SHRINKWRAP FEATURE
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Step 4 — Select Reference Model

From the Creo Parametric Dashboard open a model which geometry will be copied

| <]

| mimn— nil

Heferences Options  Properties

| |' Select 1 item

2 Select or open a reference madel

|Open a model which geometry will be gopied

Open a model which geametry will be copied

E Open

LooKInIEﬁbacK' g = cim =

FIGURE 88: SELECT SHRINKWRAP REFERENCE MQ

x|

() 19207_12488511-139 pit
() 19207_12458511-140 pit
(1 19207_12486511-141 pit
[0 19207_12486511-142 pit
[0 19207_12486511-143 pit
[0 19207_12486511-144 pit
[0 19207_12486511-145. pit

(7] 19207_12486511-163 prt
(7] 19207_12485511-164 prt
(71 19207_12486511-165.prt
[0 19207_12486511-166.prt
[0 19207_12486511-167.prt
[0 19207_12486511-168.prt
[0 19207_12486511-169.prt

m then select

[119207_12486511-146.pit
[119207_12486511-147 pit
[119207_12486511-148 pit
[119207_12486511-149 pit
[119207_12486511-152.pit
[119207_12486511-153 pit
[119207_12486511-154.pit
[119207_12486511-155pit
(7119207 12486511157 .p

[113207_12486511-170

Preview »>>

FIGURE 89: CONFIRM REFERENCE MODEL SELECTION
Step 5 - Locate the model

Define the placement by using the ACSO or CSO of the selected model and the CSO of the
new part (-801, etc). Select the OK button.

Step 6 — Choose proper Pro/ASSEMBLY options
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Select the Options tab from the Creo Parametric Dashboard

— Subszet Options

v Dependent
% Shrinkwrap and select -

" Select and shrinkwrap Refit [ atums |
— Guality

Lewvel: H

— Altributes
I™ it Hale Filling

[ Include Quits

[~ Ignore Small Surfaces

P | Threshold as percentage of model zize: ID 3:

[Bf References |Dpti0ns Properties

|| 19207_12486511.A5M (7 1) subset

FIGURE 90: CHOOSE APPROPRIATE @

Step 7 — Choose Quality Level

anw - | e - |
UNIT WEIGHT [Feal
[ 19207_BASENUMEBER-9C| 0000000
-5 NoleD_DESIGN_INTE

FIGURE 91: VERIFY REQUIRED GEOMETRY IS PRESENT

Step 8 — Toggle shrinkwrap to Independent
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Make the Shrinkwrap Independent by performing an edit definition on the external shrinkwrap
feature and removing the check from the dependent option.

| 110l
— Subszet Optiohs

[ Dependent
% Shrinkirap and select :
{7 Sielect and|shiinkwiap M
— Guality
Level: IE 3:
— Attibutes

[ Auta Hole Filling
¥ Include Guilts

™| lgnore Small Sufaces

P I Threshold ag percentage of model zize:

References | Options  Properties

| [ 19207_12486511 45M

Subzet

FIGUREQ92: T ""DEPENDANT""
The result will be a “stand alone” 3D model

by the installation components.

Step 9 — Change the colg

1. Assign colors

= Oa¥ Ug¥® =
-+ a4
(B ey BE 52 4 (12
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visibility
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Representatian
Substitlite
Explode
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Model Setup

»
Mote.  ©  lassign colors and appearances to ohijects)
REV.  Layers.., I
REY
= REY  Display Settings »
----- #= REV_E_DEGL GHY I st

FIGURE 93: ACCESS APPEARANCE EDITOR
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2. Select the color grey

B Appearance Edia

Eile Material Options ‘

COeco =
Heee -

| gray

FIGURE 94: SELECT

[ sciectlEd

Select 1 or more items.

Ok | Cancell

| Components ¥ I

| ko Clear |
Apply | meMudeI'l

w Propeiti

Basic | Mapl Advqncedl
LColor - |
rrn|nr-- |

FIGURE 95: SELECT GEOMETRY TO APPLY COLOR

4. Set the following properties: Matte=0.00, Transparency = 80.00 and select the Close button
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Basicl i ap Advanced |

— Reflection
h-!atte Feirror
| | ID.DD

— Tranzparency
Opaque

— Refraction
Air

FIGURE 96: SET TRANSPARE

The model should now look like the fol

FIGURE 97: RESULTING 3D BACKDROP
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The “backdrop” models are to be transparent instead of the 2D geometry representations. This
is a 3D backdrop not a 2D backdrop method. The structure in the model tree remains the same as with
the 2D backdrop method, as shown below.

The note named NoteO DESIGN_INTENT should be used to document the name of the
assembly used to create the shrinkwrap model. In the future when changes occur this information will

assist in updating the shrinkwrap model. The user can check-out the refereace assembly, toggle the

shrinkwrap as DEPENDANT, update the shrinkwrap, and toggle back to |

[T] 19207_BASENUMBER-E00.45M
----- £ Natell_DESIGN_INTENT

----- F= Matel

..... i: :0:93 Installation

_____ i

_____ == Notes Assembl
Note0 DESIGN_INTENT |~ o ot ’

3D Shrinkwrap

..... /7 FROMT_ASSY component
-2y ACS0 P

-2 12486511_C5Y'S

H-[] 19207_BASEMUMBER-801.PRT

[T 19207_BASEMUMBER.ASM

----- /7 ADTHI

""" 7 XSEC-E_DTM
----- /7 ADTME

----- % |nzert Here

FIGURE 98: FINAL MODEL TREE

The assembly of solid components must be separate from the models used to make the
backdrop. In this case 19207_BASENUMBER.ASM shall be used in the next level assembly without
bringing the back drop models along. Also, the backdrop models must me completely independent

from the models they are created from.
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Step 10 — Drawing Settings for 3D backdrop parts

The line type for 3D backdrops shall be PHANTOM. The color of the lines on the 2D drawing

will relate to the system settings for shrinkwraps.

Note: These steps were defined with Pro/ENGINEER Wildfire 2.0 and there
may be slight menu differences in subsequent versions of Pro/ENGINEER.
The concept should remain and slight adjustments should be manageable by
users familiar with Pro/ENGINEER.

3D-Backdrop Creation Checklist / Reference Guide

1) Checkout the required components for the 3D Backdrop into a

2) Create a temporary assembly to assemble the required back embly could
be used but to avoid accidental check-in of the assembly 4
assembly. The assembly should be built to the VCS (Ve ystem) for Chassis installations
and CBCS (Cab Body Coordinate System) for Cab installat

3) After the model is complete, export as a solid IGES file using the VCS or CBCS as the assembly
reference point. Be sure to make the file SOL )

4) Open a new file for importing the IGES file uSing tr : 3D Backdrop. Create a VCS
coordinate system as defined in the VCS portio

5) Import the solid IGES model using hich is the VCS embedded in the IGES

7) Run the FXLA mapkey : GES imported layers.
8) Assign the material prop ass Properties density to 0.0001. Write the relation
ese settings will make sure the 3D backdrop does not

generate a mass i yeight parameter on the drawing.
9) Editthe co
10) Apply AW the CAD Modeling Standard
11) Runt

12) Starta du i e the 3D backdrop into the drawing in several different views (3D, front,
i g requirements are met.

assembly or the dummy drawing.

e and check into Windchill PDMLink.

13) Do not check in
14) Save the 3D Backdre

Suggestions for a clean 3D backdrop model:

e Do not include hardware (bolts, nuts, washers ...) in the model because these will make the export
model very large.

e Components not seen in any of the views on the drawing should not be shown. The idea is to make a
simple backdrop for orientation of the components installed on the vehicle. The more “stuff” in the
backdrop the larger the file will be.
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o Remember that the lines will be in phantom so the lines will be broken up. Very small parts will not be
entirely discernible so eliminate them from the backdrop unless absolutely required.

o Pay attention to the SCALE that the drawing will be presented - that will help determine what needs to
be in the backdrop model.

Possible issues:

o If there are purple line elements in the drawing then there was an unresolved surface in the IGES file.
One way to fix this is to make a STEP file of the component before assembling it into the dummy file.
Make the IGES file again and verify that the purple entities are white.

o If the file is too large or takes too long to load, reduce the number of ¢

ents and remove hardware.
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3-Dimensional Technical Data Package Configuration Management,
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The following four tables list items and directions in order for checkers to perform their tasks.
The four checklists include CM Checklist, Standard Model Checklist, 2D PDF Drawing Checklist, and

Vendor / Legacy / Standard Model Checklist.

These four checklists were originally separate

documents but were recently combined and added to this document for reference purposes.

CM CHECKLIST

Check title block.

Item TAC | CTR
Note contents of Change Notice. X
Open Creo Parametric drawing. X
Print PDF released drawing in PDMLink and
- - X
current rev of the Creo Parametric drawing.
Paper-to-paper comparison of PDMLink ion item: Undocumen ifferences between
drawing previous rev to current Creo Parametric Creo
rev. Document any differences on NOR.
Drawing C
Open Creo Parametric drawing & perform 1 item: Model Check failed.
Model Check.
Check rev. block for correct history, rev. level & - Rev._ bI.OCk has incorrect mforr’_natlon
tory is incomplete / Rev. level is
ERR numbers. S
number is incorrect.

em: Title block has incorrect information
/ Text is outside of format boundary.

Check rev. levels on all documents

Check that drawing displays p

No layering standard for drawings. Make model
dependent on model layers instead of drawing
layers. Do not reject due to problem with archived
part/assy since nothing can be done.

General feature check.

Check that holes are features, not sketched lines, etc.

2nd Check

X

X

X

Rev. history ERR numbers may have updated
incorrectly.

TABLE 14: CM CHECKLIST

STANDARD MODEL CHECKLIST

Item TAC | CTR Comments
Note contents of Change Notice / Promote. X
Check Change Notice / Promote to determine if
NOR is needed. If there is no NOR, search X NOR is not required for initial release or the first
PDMLink for previous rev. (NOR is required if time an object is placed in PDMLink
previous rev.)
Check that only one drawing is attached to RTP. X Reject if more than one drawing is attached to an

FMTV-MODELING-STD-100T Rev.L

Page 144

13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED




3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

RTP.
Run Where Used report on each part/assembly being
promoted. Check that next up assemblies at release X Rejection item: Components do not assemble
level Preliminary Release or higher regenerate before correctly in assembly.
promoting part or assembly to Preliminary Release.
Promoting Assemblies: All subordinate items must
be at the same or higher release level than the X
assembly being promoted.
Create a workspace and check out RTP contents. X
If no drawing is present, check for PDF drawing. X Make sure drawin PDF drawing is attached to
package.
Print the NOR. X If needed.
Print the PDF Drawing. X
X
Print out released Drawing & current rev. of Creo X
Parametric Drawing.
Check that all parts/assemblies/drawings are named tds. Para. 3.8/4.5/5.15) e confirmed by
correctly X ModelCHECK only.
Paper-to-paper comparison of the released drawing ences must be documented on NOR.

previous rev. & current Creo Parametric rev.

Check parameters in PDMLink

ttachment A. Reject if any parameters have
ect/missing values.

Open Creo Parametric Drawing: Perform Model
Check at the beginning and end of the check.

Check rev. block.

umber should be correct / Rev. history and
level should be correct / Format should be correct /
Line format color should be correct / Text should
be correct size and color.

Check that correct distribution
the bottom of every drawing

Dist. Statements A, B, C, D, and X can be used.

Only Dist. Statements B, C, D, and X require an
EAR or ITAR statement.

Stds. Para. 5.11

Check that text does not exceed format boundary /
Verify title block information.

Exceptions, notes, BOM Table, symbols etc.
should be related to correct views or host entities.
(Stds. Para. 5.7)

Stds. Para. 5.8

No layering standard for drawings. Make model
dependent on model layers instead of drawing
layers. Do not reject due to problem with archived
part/assy since nothing can be done.

Switch Dimensions to check that dims, notes are
driven from the model, thus verifying that they are
parametric. (Exception: Preliminary)

Notes should be driven from model. Most or all
dimensions should be driven from model (not
created). Stds. Para. 5.1 This will not be checked.
However, overridden dimensions (@o) can be
rejection items on a case by case basis.

Parameters and notes originate from the drawing
model.

Stds. Para. 4.3 & 5.13
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GTOLs attached to base dimensions, datum planes or

surfaces, not unattached notes. X Stds. Para. 5.2

Verify correct text height.

Verify note contents & spelling.

Verify that all dimensions & geometric features are
displayed.

X | XX

Check that holes are features, not sketched lines,

General feature check. X
etc.

Verify all required geometric tolerances and datum Verify during visual check of drawing only - not at

. X
references exist.
Parts contain curves or box with note reference to X
represent part number (if necessary).
Drawing Revision is 1 higher than currently released X
version.
All drawing deficiencies in TVPDMS have been
resolved and the drawing conforms to the resolutions X
when applicable. Outstanding ECPs have been
investigated.
All differences between new & old drawings have X

been documented by NOR.

A visual check (comparison) of new & original
drawing has been completed and all required
information has been accurately transferred to the
new drawing.

t drawing conversions only. (Stds. Para.

Part Check

Perform Model Check at the beging

Run Model Player. Force regeneration.

Check layers and their status.

Check Item ID layer.

Check that correct di Dist. Statements A, B, C, D, and X can be used.

X | X [X[X]|X

: t Only Dist. Statements B, C, D, and X require an
in the mod - . EAR or ITAR statement.

(Stds. Para. 3.11)

Check part specifi€ X FMTV Tools - General Note Editor is available.
Check Model Tree for X

Features / "DWG_NOT

Check defined material and material note 2. X They should be the same.

Dummy material callout not allowed. All
Check material callout. X X appropriate material files must be assigned to part.
Primary material file is current. (Stds. Para 3.3)

Model units and Windchill PDMLink parameter

Check units (must not be Newtons) X units must be the same.
Check parameters for omissions or value errors. X See Attachment A.
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characteristics of real part.

Check for weak dimensions. X No weak dimensions allowed.

Check relations. X S;aorsgs/goanr:)r/n (;Ldt | i?]?gdard Relations" and verify

General feature check. X eCtTCk that holes are features, not sketched lines,
Verify part modeled matches latest released

Verify that the part is representative of physical X X irr?xiessitci)gact); dd_r%:ng'avaﬂstggﬁi?gniispinhave been

TVPDMS have been resolved and part conforms
to resolutions when,applicable. (Stds. Para. 2.2)

All features in the original drawing must be included

required.

in the model. X Stds. Para.
Check 3D note naming and contents X 1A ndards Pa
The part regenerates without failure or external input X < Para. 313

Assembly Check

Perform Model Check at the beginning and end of the check.

Run Model Player.

egeneration.

Check layers and their status.

Check Item ID layer.

All geometric tolerancing datum planes have been ra 4.7

added to the "G_DTM_PLANES" layer. o

Check part specific notes. FMTYV Tools - General Note Editor is available.

Check Model Tree for "Note 0" X

/ packaged components / "D

Check that correct distributio .

the model tree labeled "Distributie X Dist. Statements A, B, C, D, and X can be used.

Check that correct EAR40 X Only Dist. Statements B, C, D, and X require an

in the model tree EAR or ITAR statement.
All assembly parts must have a cage code.
Assembly cannot be promoted to Preliminary

Check for X Release until all down level parts and assemblies
that are not part of the current ECP are at release
level Released.

Check parameters for @ value errors. X See Attachment A.

Check for weak dimensions. X No weak dimensions allowed.

Check relations. X Remove any old _Standard Relations" and verify
proper comment lines.

Verify the /* has been removed from the X (Stds. Para. 3.12.4) Check by confirming

UNIT_WEIGHT=MP_MASS("") code line. Unit_Weight is appropriate.

General feature check. X gtrgeck that holes are features, not sketched lines,

L . Rejection item: Checking is being stopped at this

If 5 rejection items are found, stop checking and X point. 5 Checklist items have been discovered

return to sender. s e . . A
with invalid information. Entire package is being
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rejected. Please review all objects according to
TACOM BULLETIN-CHECKLIST-100

The only notes to be verified in down level parts
will be Note#1 (standards/specs) and the material
X note for the specific part. (EX: Assembly material
Note#6 does not have to be in Part Note#6 -> Part
note may be #2, etc. (Stds. Para. 3.5)

Check that parts of a weldment or assembly contain
all part specific notes.

Outstanding ECPs have been investigated. All

Assembly modeled matches latest released version of drawing deficiencies in TVPDMS have been

the drawing. X resolved and asse conforms to the resolutions
ds. Para 2.2)
All parts in the original drawing are included in the . . .
. uring visual comparison
model and for assemblies, that all parts are X assembly model. (Stds. Para
assembled correctly. (Ex: make sure that -001 part is y
not assembled for a -002 part)
All assembly features are present, are truly assembly X , per decision at
features, and should not be part features. 4.1.3)
The assembly of the model follows a logical X ill not be checked. (Stds. Para 4.1.2)

sequence.

The assembly regenerates without failure or external
input required.

Verify 3D note naming and contents.

No packaged components unless appropriate. ara. 4.1.5

Voting Notifications

Rejections Note: After voting to rejécta i ust be locked and transferred back to the originator.

Voting: After voting, send an eg
the originator.

X Rejection notification or Approval Notification.

2nd Check

Run Model Chec

Run Model PI X
Check that X

. Rev. history ERR numbers may have updated
Double che ' X incorrectly.
All required paramet®
Drawing, Part, Assembly VILink parameters X Stds. Para. 2.8.1
are set to the correct (& same) level.
Unit_Weight is appropriate for parts & assemblies. X Stds. Para. 3.12.4

X Stds. Para. 2.10 — Not required

NOR doqument is filled out and related to the Creo X Stds. Para. 2.10
Parametric drawing as attachment
All parts defined by a drawing are related to the
drawing even if they are not used in a view on the X Stds. Para. 5.12
drawing. (Ex: -500, -800 part)
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Stds. Para. 2.10

TABLE 15: STANDARD MODEL CHECKLIST

2D PDF DRAWING CHECKLIST

Iltem

TAC

Note contents of RTP.

Reject if ent is attached to RTP.

Check that only one drawing is attached to RTP.

ect if more than one is attached to an

Create a workspace and check out RTP contents.

Print the NOR.

A Comments sheet is attached to

Print the PDF Drawing.

Update QA Comment form to reflect contents of RTR
Print out released Drawing previous rev.

Check that PDF drawing is named correctly.

Paper-to-paper comparison of the CM
rev. & current PDF rev.

Any differences must be documented on NOR.

Verify that all changes listed on )
incorporated on PDF drawing

See Attachment A. Reject if any parameters have
incorrect/missing values.

RTP items m X

originator,

V(.Jt'.ng: A X Rejection notification or Approval Notification.
originator.

Do not need to do a full cheek’of everything.

Unless 5 items were previously rejected, then
recheck completely.

TABLE 16: PDF DRAWING CHECKLIST
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VENDOR/LEGACY/STANDARD PART MODEL CHECKLIST

QAL or higher regenerate before promoting part or
assembly to QAL.

Item TAC | CTR Comments
Note contents of RTP. X
Check RTP to determine if NOR is included. If there is
no NOR, search Pro/INTRALINK for previous rev. X
(NOR is required if previous rev.)
Check that only one drawing is attached to RTP. X aRr?JIgFI:(F:f more than one drawing is attached to
Run Where Used report on each part/assembly being
promoted. Check that next up assemblies at release level X X

Promoting Assemblies: All subordinate items must be at
the same or higher release level than the assembly being
promoted.

Create a workspace and check out RTP contents.

If no drawing is present, check for PDF drawing.

Print the NOR.

Print the PDF Drawing.

Update QA comments form to select contents of RTP

Print out CM-Stat Drawing & current rev. of Creo
Parametric Drawing.

Check that all parts/assemblies/drawings are named
correctly

Paper-to-paper comparison of the CM
rev. & current Creo Parametric rev.

Any differences must be documented on
NOR.

Check parameters in PDMIink.

See Attachment A. Reject if any parameters
have incorrect/missing values.

Run Model Player.

X Force Regeneration.

Check parameters fg

X See Attachment A.

Verify part modeled matches latest released
revision of drawing. Outstanding ECPs have
been investigated. All drawing deficiencies in
TVPDMS have been resolved and part
conforms to resolutions when applicable.
(Stds. Para. 2.2)

Part regenerates wi
required.

X Stds. Para. 3.1.3

Notifications

Rejections Note: After voting to reject an RTP, all RTP

items must be locked and transferred back to the X
originator.
Voting: After voting, send an email notification to the X Rejection notification or Approval
originator. Notification.
Verify that part can be assembled into next higher X
assembly.
2nd Check
Run Model Check. X
Run Model Player. X
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Check that rejection items are fixed. X
. Unless 5 items were previously rejected, then
Do not need to do a full check of everything. X recheck completely.
Double check that rev. block is correct. X Rev. history ERR numbers may have updated
incorrectly.
Windchill PDMLink
All required parameters have been correctly entered. X

If values are known, enter the following
parameters: PART _NUMBER,

. DRAWING BER, CAGE_CODE,
For Vendor supplied and standard part models, a reduced X RE, UNIT WEIGHT,

number of parameters are required. V. MODELER NAME 1

TABLE 17: VENDOR / LEGACY / STANDARD PART EL CHECKLIST

Revision
12421234.drw where 12421234

D.6 Procedure for Promoting Objects to

e Check the Objects into Commonspace
e Windchill Parts and Drawings shall also be revised at the same time.

o Refer to PDMLink User Guide for a Step by Step Guide on how to Promote Objects
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D.7 Superseded and Obsolete Parts

A superseded or obsolete part should not be modeled. The main goal is to model only active
parts on a drawing, thus superseded/obsolete are not needed. If the drawing has both superseded and
active parts, only model the active parts. The following is only if the drawing has not been

converted to Creo Parametric.

How this is handled:

e Remove the Superseded / Obsolete part from the drawing

o If the Superseded / Obsolete part is on the sheet before th ctive part, move the

production / active part to the earlier sheets and remo

e Update Part Tables (If any) to the superseded
the SHEET column or in the DESCRIPTION col

FROM:

PART NO.
12417336

124175

TO:

TABLE

PART NOT HEETS COMMENTS
12417336 REMOVED AT REV.E |SUPERSEDED BY [2417336-001
2417336-0 I SUPERSEDES 12417336

FIGURE 99: FROM-TO EXAMPLE
e Document all changes as normal in the NOR, including removal of sheets, updating of tables,

moving the production/active part to earlier sheets, etc.

If the drawing is completely obsolete (no active parts on the drawing), do not model that part or

drawing. If for some reason the models are required it can be modeled, but that should be a rare case.
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If the drawing has already been converted to Creo Parametric and a future revision will
supersede / obsolete a part on the drawing, the model shall NOT be removed from the drawing. This

will allow the user to leave the models on the drawing and not have to shift around multiple views.

D.7.1 Superseded and Obsolete Parts — Revision Block

The revision block shall conform to the ASME Y14.35M standard. In addition, if a part is
states SUPERSEDED

superseded by a new drawing, place a marking above the Title Bloc
BY 12XXXXXX (part number) in a balloon as depicted in Figure

//““\\g,/////_\\\\\m/////”i\\\\\_,///Ax\\\\gg/—
( SUPERSEDED BY 1256173

ED FROM A SOLID MOGEL
CHANGES SHALL BE
SION ACTIVITY.

THIS DRANTNG WA
AND 15 CAD MAIN

\CT NUMBER
DAREOT-92-1-ROD|
ACTGR

)58
OMOTIVE & ARMEMENTS COMMAND
{EN, MICHIGAN 43397-5000

ASSEMBLY, STOWAGE

bWe NO

12345678

. SHEET
.65 ka REF| I OF |

UNTT WT

I
RE 100: SUPERSEDED CALLOUT

All labels and plates (placards) are to be created and maintained in Creo Parametric.

D.9 Installation Drawings/Assemblies
All installation drawings/assembly models shall contain a Vehicle Coordinate System (VCS) for ease

of assembling to Chassis and Top Level models (Refer to Appendix E).
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E Vehicle Coordinate System

E.1 \ehicle Coordinate System (VCS)
Note: The VCS listed below for FMTV was established for the FMTV A1P2 variant. The information

remains for historical purposes only.

The VCS is the driving base coordinate system for all FMTV trucks. The \/ES is established by the

intersection of the 3 Planes representing the length, width and hei the truck; x, y and z

respectively. The 3 planes coincide with the axis through the E Dat he frame rails for the X

et 1501
(@ 15050 [A-AlAx 800 [D]

- W

B0
EACE I EEEE !

(650 [ Alo[acs <0

FIGURE 101: VCS ESTABLISHED ON ROADSIDE FRAME RAIL
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FRONT_ASSY.

FIGURE 102: VCS IN DEFAULT VIEW

In “default” view € e VCS is established at the intersection of the three default assembly

datum planes. Notice the'orientation of the X, Y and Z datum references. This is essential that they are

oriented in this manner or the whole purpose for the VCS is of no value.
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FRONT_ASSY

IDE_ASSY

FIGURE 103: VCS WITH FRAMERAIL

The same default view with the frame assembly added for clag ion is shown
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TOP_ASSY

FRONT_ASSY

<

'v" y [ & .

IDE_ASSY

Fic B4: VCS IN DEFAULT WITH FRAMERAIL

For Instaliatie ateéd with the VCS in mind, the VCS coordinate as shown is at the
planes and the XYZ orientation established as shown earlier. If the
Installation assemb puilt off the default datum planes, then the VCS coordinate can still be
OFFSET by either a set 0f datum planes, curves, points or by another coordinate system.

Front Cab Mount Installation shown below with the VCS and CBCS (Cab Body Coordinate System —

explained later).
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% VS

FIGURE - FRONT CAB TALLATIONWITH VCS

The Installation bled to the Frame assembly by mating the 2 VCS coordinate system

points and it will snag ace as shown below.
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[C] 19207_12505503-002. ASM 681,04
‘- o Insert Here 4

¥ Constraint Enabled

[2 15207_12505178:vCs: 7 C"fmim Type
Cood Sy 7| fi
[Zgvcsrsicsys) Cmbaieel il

New Constraint Dffset

[ = noT o]

Status
Fully Constrained

Eﬂ Placement Move Flesbiity  Properties
@EI B ILlsar Defined j

o Select coordinate system from other model.

New Set

=l

[Lcoomsys =] [noToERmER] 4 STATUS : Fully Cg

FIGURE 106: FRONT CAB MOUNT ASSEN

FIGURE 107: FRONT CAB MOUNT INSTALLED

E.2 Cab Body Coordinate System (CBCS)

The CBCS is the coordinate system for the Cab body and all related installations shall have a

coordinate placed and named as the CBCS. The top level Dressed Cab model shall have the VCS
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included in it as well. The CBCS varies between the different cab designs but it shall be established by
following the same X Y Z relationship and orientation as the VCS.

The location of the LTAS Cab CBCS and the chassis VCS is shown below:

CBCS

FIGURE 108: CBCS OFFSET FROM VC NSIONS

»

FIGURE 109: CBCS IN DEFAULT ORIENTATION
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E.3 Roadside (aka RS and Driver Side) and Curbside (aka CS and
Passenger Side)
The “roadside” of the vehicle is the side of the vehicle that is parallel to the road and the “curbside” is

the side parallel to the curb. The usage of Left side and Right Side can be confusing because in

orthographic drafting terms, the roadside view is the right side but WRT vehi€ular terms, it is left side

because that is how the view is observed by the Driver while sitting in hicle. For clarity and

uniformity, roadside and curbside have been designated.
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F  Special Partand Drawing Types

F.1 Standard Parts

Standard parts are components defined by standards organizations and are not under the control
of the Tactical Vehicle (TV) group at TACOM. These would include parts defined by SAE, NAS,

ANSI, and MS to name a few. These parts are modeled as needed and reflect the size shape and

weight of the actual parts. An abbreviated set of parameters is needed f ese parts. As these parts

are not controlled by TV, a drawing is not created, and an ECP | essed. Parts should be

drawing in either the notes 8 ithin the\Table (See Figure 110). Users can use table
sbpartslist_spec.tbl in Cqg specs are called out on a drawing, the table

method is preferred.
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6 2 [MS51029-5] SSCR-HEX SOC,FL PT.ALY STL 80205 NASMS1 029
15 | [Ws24665-516 PIN, COTTER (SPLIT) 80205 NASH24665
|4 | [Ws5r472-0] NUT 96906 MS51472
13 2 [MS35649-2254  [WUT, HEX, I/4-20 UNC-2B 80205 NASM35649
E | [Wssi930-1 PAD EYE 96906 MS51930
I 2 [Br8221BHI25W  [WASHER 80204 | ASME B18.22.
0 2 [B1822IBHO63N | WASHER B0204 | ASME B18.22. |
3 | [Ws16842-3 CLAMP,WIRE ROPE/DOUBLE GRIP/THREADED, STEEL 96906 M5 16842
8 I 11636670 BOLT
7 | 11636668 CABLE
6 | 11636665 U-BOLT
5 I 11636591 PAWL ASSY
I I [I1592686 MEMBER
3 | [Ir592657 SHAFT ASSY
2 2 [11592658 FLANGE
| | 7409903 SPRING PLUNGER LATCH

FP‘JSDGTY PART NUMBER SPECIFICATION

F.2 Common Parts

Common parts are parts that have and are used across multiple

systems. They must be released pe an Administrative 2 ECP (assuming no real
content changed) to speed thg p a Common part? Items to look for: Does the
drawing contain all the ly manufacture the part? If not, it may be a
common part. Is it an item stocked normally (e.g. clamps, bolts, nuts)? Does the drawing

reference othe 5 e.g. is there a DIN (or other) part number called out on the

F.3 Deformed parts

Deformed parts are parts that change shape upon installation. These parts have a couple of
subdivisions that are treated differently. Items that are always deformed fairly consistently upon
installation e.g. pop rivets, lock washers etc. have an uninstalled model(s) named with a —998 (and

lower) for pictorial use on the drawing. The installed versions are created in their deformed state and
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named with the standard dash numbering system. Items with a specific grip range should be modeled
at their maximum grip range. The reason for this approach is to limit the vast number of parts that
would be created if a model had to be created for each possible variation in installation. Items that are
deformed differently upon each installation e.g. hose clamp, springs, etc. will use a —900 series part of
the up assembly. The parameters of the =900 part should reflect the parameters of the up assembly

except for Nomenclature, drawing number and most importantly part n r. This method was

implemented when it was discovered that the previous practice of ‘part er_in_partnumber’ did not

work if there were dash numbers in both part numbers. This work able to be eliminated

in future versions of Creo Parametric. Flexible components till the prefe ethod in lieu of

creating a -900 series part.

For example:
MS21266-2N (Grommet, Plastic, and E hat 1S used in many assemblies and is

deformed differently each time.

F.4 \endor ItemiControl Drawings

Specification Control drawings now changed to Vendor Item Control Drawing. Parts in this
category generally do not have complete definition of the part required to manufacture the part.
Dimensions that do not appear on the drawing are not checked. If missing dimensions, actual parts
should be obtained and measured to create a model that is representative of the actual part and allow a

drawing to be created that is similar to the original. The part should be weighed and an appropriate
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weight defined in the part. Sectional views that are for general information do not have to be recreated

during the conversion efforts. If there is required information in the section, it still has to be created.

F.5 Source Control Drawings

Similar to Vendor Item Control Drawings as far as modeling is concerned. They will often

have even fewer dimensions. If a model is available from a vendor b s not have all of the

parameters etc. then an assembly should be made using the TV s sembly. All appropriate
parameters etc can then be filled out in the assembly. For Sou ctrical drawings, see

section 7.1.20 for Schematic reference.

F.6 Installation Drawings
In Appendix D.3 of this document,

e ECP’s as well as the fact that the baseline of the truck has not yet
been released, R parts and drawings are treated a little differently. For checking purposes, three
parameters do not pe filled out. Drawing Number, Tolerance Angle, and Weight Unit.
‘Background’ or ‘Legacy’ parts are parts that are created to complete an installation, but are not the
released version of the part; do not have to be checked. These parts do not have the cage code
identifier in the front of the file name. They should have an ‘OLD_" at the front to help eliminate the

chance they are used in lieu of the released parts in the future.
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